System Copy Guide
System Copy for SAP Systems Based on SAP NetWeaver 7.1 Java
SAP NetWeaver Composition Environment 7.1

Target Audience
- System administrators
- Technology consultants

PUBLIC
Document version: 1.4 – 2009-12-09
Document History

CAUTION
Before you start the implementation, make sure you have the latest version of this document. You can find the latest version on SAP Service Marketplace http://service.sap.com/instguides.

The following table provides an overview on the most important document changes:

<table>
<thead>
<tr>
<th>Version</th>
<th>Date</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.40</td>
<td>2009-12-09</td>
<td>Update in IBM DB2 for Linux, UNIX, and Windows Specific Procedures</td>
</tr>
<tr>
<td>1.30</td>
<td>2009-09-14</td>
<td>Updates in Generating DDL Statements, Starting SAPinst on IBM i, Oracle-Specific Procedures, and Performing Follow-Up Activities for ABAP</td>
</tr>
<tr>
<td>1.20</td>
<td>2009-07-06</td>
<td>Update in Performing Jobhead Correction after Homogeneous System Copy</td>
</tr>
<tr>
<td>1.10</td>
<td>2009-01-13</td>
<td>DI-, EP-, and EPC-specific information updated</td>
</tr>
</tbody>
</table>
# Table of Contents

<table>
<thead>
<tr>
<th>Chapter 1</th>
<th>Homogeneous and Heterogeneous System Copy for SAP Systems Based on SAP NetWeaver</th>
<th>7</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.1</td>
<td>Terminology</td>
<td>7</td>
</tr>
<tr>
<td>1.2</td>
<td>Information on SAP Service Marketplace</td>
<td>8</td>
</tr>
<tr>
<td>1.3</td>
<td>Accessing the SAP Library</td>
<td>8</td>
</tr>
<tr>
<td>1.4</td>
<td>Constraints</td>
<td>8</td>
</tr>
<tr>
<td>Chapter 2</td>
<td>Planning</td>
<td>11</td>
</tr>
<tr>
<td>Chapter 3</td>
<td>Preparations</td>
<td>15</td>
</tr>
<tr>
<td>3.1</td>
<td>General Technical Preparations</td>
<td>15</td>
</tr>
<tr>
<td>3.2</td>
<td>Usage-Type-Specific Preparations</td>
<td>15</td>
</tr>
<tr>
<td>Chapter 4</td>
<td>Database Independent System Copy</td>
<td>17</td>
</tr>
<tr>
<td>4.1</td>
<td>System Copy Procedure</td>
<td>18</td>
</tr>
<tr>
<td>4.2</td>
<td>Exporting the Source System Using SAPinst</td>
<td>19</td>
</tr>
<tr>
<td>4.2.1</td>
<td>Running SAPinst on UNIX or Windows to Perform the Export</td>
<td>19</td>
</tr>
<tr>
<td>4.2.2</td>
<td>Running SAPinst on System i to Perform the Export</td>
<td>22</td>
</tr>
<tr>
<td>4.2.2.1</td>
<td>Starting SAPinst on System i</td>
<td>22</td>
</tr>
<tr>
<td>4.2.2.2</td>
<td>Preparing a System i User Profile</td>
<td>24</td>
</tr>
<tr>
<td>4.2.2.3</td>
<td>Copying the DVDs Manually Using the ROOTBIN Share</td>
<td>25</td>
</tr>
<tr>
<td>4.3</td>
<td>Setting Up the Target System</td>
<td>27</td>
</tr>
<tr>
<td>4.3.1</td>
<td>Transferring the Export Files to the Target Host</td>
<td>28</td>
</tr>
<tr>
<td>4.3.2</td>
<td>Installing the Target System</td>
<td>28</td>
</tr>
<tr>
<td>Chapter 5</td>
<td>Database-Specific System Copy</td>
<td>31</td>
</tr>
<tr>
<td>5.1</td>
<td>Oracle-Specific Procedure</td>
<td>32</td>
</tr>
<tr>
<td>5.1.1</td>
<td>Generating the Control File Structure</td>
<td>33</td>
</tr>
<tr>
<td>5.1.2</td>
<td>Creating a Backup</td>
<td>37</td>
</tr>
<tr>
<td>5.1.2.1</td>
<td>Creating an Offline Backup</td>
<td>38</td>
</tr>
<tr>
<td>5.1.2.2</td>
<td>Creating an Offline or Online Backup with BR*Tools</td>
<td>38</td>
</tr>
<tr>
<td>5.1.3</td>
<td>Preparing the Target System (Oracle)</td>
<td>38</td>
</tr>
</tbody>
</table>
5.1.4 Restoring the Database Files on the Target System ........................................ 41
5.1.5 Restoring the Database Files on the Target System with BR*Tools ............... 42
5.2 MaxDB-Specific Procedure .................................................................................. 43
5.3 MS SQL Server-Specific Procedure ................................................................... 45
5.4 IBM DB2 for Linux, UNIX, and Windows Specific Procedures .......................... 46
5.5 IBM DB2 for i5/OS Specific Procedure ............................................................... 48
5.6 IBM DB2 for z/OS Specific Procedures .............................................................. 48
5.6.1 Step 1: Check Consistency ............................................................................. 50
5.6.2 Step 2: Stop and Restart the Source System .................................................. 51
5.6.3 Step 3: Run SQL Statements in the Source System ......................................... 51
5.6.3.1 SQL Statement Number 01 ........................................................................ 51
5.6.3.2 SQL Statement Number 02 ........................................................................ 52
5.6.3.3 SQL Statement Number 03 ........................................................................ 52
5.6.3.4 SQL Statement Number 04 ........................................................................ 53
5.6.3.5 SQL Statement Number 05 ........................................................................ 54
5.6.3.6 SQL Statement Number 06 ........................................................................ 55
5.6.3.7 SQL Statement Number 07 ........................................................................ 56
5.6.3.8 SQL Statement Number 08 ........................................................................ 57
5.6.3.9 SQL Statement Number 09 ........................................................................ 57
5.6.4 Step 4: Capturing View Definitions with DB2 V9 (if the Schema Name is to be Changed) ................................................................. 58
5.6.5 Step 5: Stop the Source System ..................................................................... 59
5.6.6 Step 6: Making Copies of Source Data Sets .................................................... 59
5.6.7 Step 7: Creating the Target System ................................................................. 59
5.6.8 Step 9a: Changing the Bootstrap Data Sets (BSDS) ......................................... 60
5.6.9 Step 9b: Start the Target System ................................................................... 60
5.6.10 Step 9c: Creating a New STOGROUP Using the HLQ of the Target System ........................................................................................................ 61
5.6.11 Step 9d: Stopping Index Spaces ..................................................................... 61
5.6.12 Step 9e: Changing the User-Defined Indexes in the DB2 Catalog .................. 62
5.6.13 Step 9f: Restart the Index Spaces .................................................................. 62
5.6.14 Step 9g: Creating the Temporary Files for the DB2 Target System ................ 62
5.6.15 Step 9h: Implementing HLQ of the Target System in the Work File Database ........................................................................................................ 62
5.6.16 Step 9i: Adjusting the DDF Location Name and Port Number ....................... 63
5.6.17 Step 10 (DB2 V8 and Lower): Changing the VCAT of the Target System ........ 63
5.6.18 Step 10 (DB2 V9): Changing the VCAT of the Target System ....................... 64
5.6.19  Step 11 (DB2 V9): Changing the Schema of the Target System  ............... 64

5.6.20  Step 12: Adapting WLM Application Environments for DB2 Stored
        Procedures ........................................................... 65

Chapter 6  Copying Single Instances Only .................................................. 67

  6.1  Copying the Database Only – Move ............................................ 67

  6.2  Copying the Database Only – Refresh ....................................... 68

Chapter 7  Follow-Up Activities .............................................................. 71

  7.1  Performing Follow-Up Activities in the Target System .................... 71

  7.1.1  Installing the License Key .................................................... 71

  7.1.2  Performing Follow-Up Activities for Java ................................ 71

  7.1.2.1  General Follow-Up Activities ............................................ 71

  7.1.2.1.1  Generating Public-Key Certificates ................................ 72

  7.1.2.2  Software Unit-Specific Follow-Up Activities ......................... 72

  7.1.2.2.1  AS Java: Adobe Document Services ................................. 72

  7.1.3  Performing Jobhead Correction after Homogeneous System Copy .... 73

Chapter 8  Additional Information .......................................................... 75

  8.1  Additional Information About SAPinst ........................................ 75

  8.1.1  Using SAPinst GUI ............................................................. 75

  8.1.2  Useful Information About SAPinst ........................................ 76

  8.1.3  Interrupted Installation with SAPinst ..................................... 79

  8.1.4  Performing a Remote Installation with SAPinst (Optional) ............ 81

  8.1.5  Starting SAPinst GUI Separately (Optional) ............................ 85

  8.1.6  Entries in the Services File Created by SAPinst ....................... 89

  8.1.7  Troubleshooting with SAPinst ................................................ 90
This page is left blank for documents that are printed on both sides.
1 Homogeneous and Heterogeneous System Copy for SAP Systems Based on SAP NetWeaver

Purpose
With SAP NetWeaver you can copy SAP systems in one run using either database-independent methods or database-specific methods.

1.1 Terminology

■ System Copy
Duplication of an SAP system. Certain SAP parameters might change in a copy. When you perform a system copy, SAPinst installs all the instances again, but it uses a copy of the source system database to set up the database.

■ Source System and Target System
The SAP system containing the original database is called the source system and the system to which the database copy is to be imported is called the target system. Their SAP system names are abbreviated to SOURCE_SAPSID and TARGET_SAPSID. The terms source database and target database are also used in this description.

■ Homogeneous System Copy
During the system copy you use the same operating system and database platform as the original system.

■ Heterogeneous System Copy
During the system copy, you change either the operating system or the database system, or both. Heterogeneous system copy is a synonym for migration.

■ Database Copy
Database-dependent part of the system copy.

■ Placeholders
Placeholders such as <SAPSID> are used in commands. They are used in the same way as in the SAP system installation documentation. You must replace them with the values valid for your site.

The following additional placeholders are used:

<table>
<thead>
<tr>
<th>Placeholder</th>
<th>Meaning</th>
<th>How to find out</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;SAPSID&gt;</td>
<td>SAP system ID</td>
<td></td>
</tr>
<tr>
<td>&lt;S_HOST&gt;</td>
<td>System name of the source host</td>
<td>Command hostname</td>
</tr>
</tbody>
</table>
1.2 Information on SAP Service Marketplace

For more information about system copy, see the documentation on SAP Service Marketplace:


In addition to the information contained on this page, check the SAP OS/DB Migration Planning Guide that is available in the Media Library.

- SAP Note [82478 – R/3 OS/DB migration](http://service.sap.com/osdbmigration).

**CAUTION**

Only perform a system copy if you have experience in copying systems and good knowledge of the operating system, the database, and the Java Dictionary. Only perform a heterogeneous system copy if you are a certified system support consultant or a certified SAP Technical Consultant.

**NOTE**

If you have problems during the system copy, create a customer message as follows:

- For a **homogeneous** system copy, use the application area BC-INS-UNIX (UNIX), BC-INS-NT (Windows), or BC-INS-AS4 (IBM System i).
- For a **heterogeneous** system copy, use the application area BC-INS-MIG.

1.3 Accessing the SAP Library

For more information about SAP NetWeaver, access the SAP Library from the SAP Help Portal at [http://help.sap.com](http://help.sap.com).

The references to SAP NetWeaver Library documentation in this documentation always refer to the following entry point on the SAP Help Portal:

1.4 Constraints

- As of SAP NetWeaver 7.0, when your system is a double-stack system and you perform a system copy, your source system is copied to the target system as a whole. This means, that it's neither possible to exclude a single stack from the system copy nor to copy a separate stack only.
SAP does not support client transport as a system copy method. Transporting production clients is not supported at all. You can use client transport for the initial setup of a SAP system infrastructure. This documentation does not cover the client copy procedure.

This documentation does not describe how to export and import a database with the installation tools for reorganization purposes. Use the appropriate tools for database reorganization, as SAP does not support this installation option.

If you have made modifications in your development system and want to copy your quality assurance or production system onto the development system, see SAP Note 130906.

This documentation describes how to copy data from one SAP system to another SAP system based on SAP NetWeaver Application Server. This documentation does not describe how to copy data from non-SAP systems to SAP systems.

If you want to convert a non-Unicode system to a Unicode systems or perform the system copy of a Unicode system, see SAP Note 551344.

For the development of Java applications, we strongly recommend that you follow the rules mentioned below. Otherwise, we cannot guarantee that you will be able to copy your Java Engine later with the SAP tools to change your underlying operating system and/or database system.

SAP does not generally support all Data Archiving operations after a system copy. If you used Data Archiving in the source or in the target system, access to the created archive file(s) from the target system may not always be possible. For more information see SAP Note 153433 and System Landscape Optimization at http://service.sap.com/slo.

Access to archived files from the target system without a dedicated archive migration project is only supported in the following cases:

- Your system copy clones a source system for non-productive purposes, only read-access to the previously archived data is intended from the target system (no reloading), and you do not store archive files using ArchiveLink/CMS.
  
  You can either copy all archive files to file systems that are not shared between the source and the target system, or you arrange network access for appropriate archive file sharing.

- The system copy is done to replace a productive system by a new productive system (e.g. hardware migration), assuming that the target system did not exist before and the source system’s operation is discontinued after the system copy.
  
  You must not change the system ID during system copy, but arrange for file access and/or ArchiveLink/CMS connectivity.

In all other cases, contact SAP SLO at http://service.sap.com/slo or slo.consulting@sap.com.

When you perform a system copy, all software units in the source system are copied to the target system. This means that none of the software units in the target system can be excluded from the system copy, nor can you select software units.

Dos and Don’ts for system copy:
1.4 Constraints

- **Do:**
  - Save configuration data and runtime data in the Java database only.
  - Follow the Open SQL standard.
  - Make sure that all communication runs through the database pool.

- **Don’t:**
  - Save any system and infrastructure-specific data in business objects. Use a pointer to the central storage of such information, for example:
    - SAP SystemID and SID (SAPSID = SID = system name)
    - Host name
    - IP addresses
    - Services and Ports
    - Logical destinations and logical system names
    - Other technical infrastructure names
  - Use file system persistency.
  - Set up dependencies between Java and ABAP.
  - Try to copy the Java part of an ABAP+Java system to a Java standalone system or vice versa.
This section describes how to plan your system copy.
You can apply the system copy for:

- Setting up system landscapes (where the SAP systems have different SAPSIDs).
- Creating systems for testing, demonstration, training, and standby. Depending on the purpose of the system, it might be advisable to use the same SAP system ID, even though this prevents you from including the system in a system group for transports.
  You can use different operating system releases or database releases for the source and target systems, but the SAP system release of the source and target systems must be the same.

**NOTE**
You cannot create standby systems with a system copy.

**NOTE**
You should perform upgrades in a test system first. This way you can identify customer-specific problems that might result from modifications.

**CAUTION**
Do not use NFS-mounted file systems because writing to NFS-mounted file systems might cause corrupted dumps.

When copying a system which contains production data it is important to choose the right moment for the copy. This could be a month-end or year-end closing.

**Required Documentation**

- Read the following SAP Note for up-to-date information:
  SAP Note 1042437 (System Copy for SAP NetWeaver Based on Kernel 7.10)
  Make sure that you have the most recent version of the SAP Notes, which you can find at:

**Required DVDs, Tools, and Other Software**

- **Required DVDs**
  Make sure that all required DVDs for the system copy are available:
  - Installation Master DVD
- Java DVD

- Order the right version of the installation kit before starting the system copy. Make sure that the versions of the SAP system and the installation tools are the same on the target and source systems. Exceptions are only allowed if they are described in an SAP Note.

**NOTE**
You can operate several SAP systems including their databases on a single host without encountering any problems. However, SAP recommends that you use a separate host for each system because an SAP system upgrade might depend on an OS upgrade. If the SAP systems are on separate hosts, you can upgrade them at different times.

**CAUTION**
The source system must be in a **consistent** state before you can copy it.

- Check that you have the appropriate **tool versions** for your SAP kernel.
- Check whether you have to **download archives** at [http://service.sap.com/swdc](http://service.sap.com/swdc).

### Creating A System Copy Plan
Create a plan to perform the system copy.

1. **Consider the downtime of the source system** (for preparations and copying) when planning the system copy.
2. **Consider a test run**
   - Perform a test run of the system copy. You can use the time taken by the test run to calculate the system downtime:
     - If your target system will replace your source system, try to perform a complete test run. This means that the entire database is exported from the source system, transferred to the target system and imported there. System downtime is approximately equal to the total test time (that is, time for export, transport, and import).
     - If you do not want to replace your source system, a partial test run (export of the entire database or parts of it) can be sufficient to calculate the system downtime. The source system is only down for the time of the export.
   Calculating the system downtime is particularly important for very large databases (VLDB) or when tapes are being used. The test run is also to determine the amount of export data. Choose the best data transfer method (for example, FTP or tape). We recommend that you perform read/write actions only on local file systems.
3. **Define a schedule for the test migration and the final migration.**

### Miscellaneous
- In the event of a **major change in hardware configuration** (for example, new machine type, new hard disk configuration, new file system type), consult your SAP-authorized hardware partner.
- Decide which system copy procedure you want to use:
The database-independent procedure [page 17] using SAP tools
Use this method if database-specific methods are either not available or not suitable.

**NOTE**
For a database-heterogeneous system copy and for Unicode conversion, only the database-independent method is available.

The database-specific procedure [page 31] using tools provided by the database vendor
Some database vendors offer specific tools for copying a database. These tools let you:
- Restore a backup of one database (source database) in another one (target database) (backup method)
- Unload the source database and load the data into the target database

Copy single instances only
- Copy the primary application server instance only [page 0].
- Copy the database only (using SAPinst) [page 67]
- Copy the database only (using database refresh) [page 68].

**CAUTION**
You cannot copy single usage types or components!

### Changing the system variant
If you want to change your system variant (for example, if you want to make your standard system a distributed or high-availability system), proceed as follows:
1. **Perform the export [page 19].**
2. For the import choose the relevant system copy options as described in the process flows of the system copy procedure [page 18].

### Choosing an SAP system ID
You can choose the new SAP system ID `<TARGET_SAPSID>` freely during a new installation.

**CAUTION**
To meet the requirements of the Workbench Organizer, you must choose different SAP system IDs for different SAP systems.

### SAP license
Once the installation is completed and the SAP system copy has been imported, you will require a new license key for the target system. The license key of the source system is not valid for this system. For information about ordering and installing the SAP license, see the SAP Library [page 8] at Administrator’s Guide → Technical Operations for SAP NetWeaver → General Administration Tasks → License Administration.

For more information about SAP license keys, see [http://service.sap.com/licensekey](http://service.sap.com/licensekey) or SAP Note 94998.

### Archiving files
Data that has been archived in the source system (data that does not reside in the database but was moved to a different storage location using SAP Archive Management) must be made accessible.
in the target system. Adapt the file residence information in the target system. For more information, see the SAP Library [page 8] at Administrator's Guide → Technical Operations for SAP NetWeaver → General Administration Tasks → Data Archiving.

Access to archive files is platform-independent.

- **Configuration analysis and hardware analysis**
  You need to determine the:
  - Number of application servers
  - Expected size of the database
  - Additional disks or other hardware required
  - Required memory

**NOTE**
See the section on hardware and software requirements in the SAP system installation documentation to determine the system requirements.
3 Preparations

Before you start the system copy, you must perform the following preparation steps:

### 3.1 General Technical Preparations

**Procedure**

To make a consistent copy of the database, you need to prepare the source system and perform some subsequent actions on the target system. This is not necessary when performing a test run.

The following describes important preparations on the source system. For more information about SAP system administration, see the SAP Online Documentation.

- Before you start a system copy, check the minimum kernel patch level required by the support package level of the source system. It might be necessary to replace the SAP kernel delivered with the kernel DVD of the installation kit and installed during the installation of the target system by a newer kernel patch level before starting the target system. If you have to replace the delivered SAP kernel, you can do this after the installation of the primary application server instance.

### 3.2 Usage-Type-Specific Preparations

**Procedure**
4 Database Independent System Copy

You can use the SAP installation tool SAPinst to export and import your Java database content, file system, and all configuration in a database-independent format. SAPinst uses the Jload tool. Jload generates a database export of all SAP objects that are defined in the Java Dictionary and archives the configuration and components in the file system.

Constraints
Jload Restrictions
- SAPinst generates a database dump of all SAP objects that are defined in the Java Dictionary (Jload). Other objects are not exported by SAPinst.
- For a consistent database export, no transactions on export-relevant database objects are allowed during the export. Otherwise, the export has to be restarted. Therefore, we recommend that you shutdown the SAP system (excluding the database!) for the export. The database must still be running.

Existing Target System
If the target system already exists and **if you do not plan to perform an MCOD installation**, delete the database on the target system before the import according to the corresponding description in section Additional Information of the installation documentation for your SAP component.

If the database configuration of your database is stored in the file system, we recommend you to back up these configuration files before deleting the database.

Splitting STR Files
- During the standard system copy process, all tables of the SAP system are grouped into packages, whereby all tables with the same “data class” belong to the same package. The processing unit for one unload/load process is a package. The packages usually differ in number and size of contained tables, resulting in varying unload/load runtimes. The overall runtime can be reduced by creating packages of the same “size”, that is, creating packages with a similar processing time. You can achieve this by splitting the default packages (one package per data class) into more and smaller pieces.
- There are several options of how to split packages. For a detailed description of the options, see the F1 help about the parameters prompted on the screen Split STR Files while running SAPinst to export the database. The options can be used separately or – when using the new Java based splitting tool – combined.
“Splitting of STR Files” is part of the “Advanced Export Parameters” and is disabled by default. If you select the splitting option (if you did not already perform some tests before), using the splitting tool parameters selected by SAPinst is a good starting point.

**CAUTION**

If you want to split STR files, you **must** first create the EXT files for the target database system. You can find the EXT files in your export dump directory, subdirectory `DB/<DBTYPE>`, for example `DB/ORA`.

### 4.1 System Copy Procedure

This section describes the **system copy procedure using Jload**.

**Procedure**

**Process Flow on the Source System (Export)**

When performing the export you create a MIGRATION EXPORT CD image, which contains the data of the exported system, and which you use to install the target system.

Follow the sequence of steps described in the process flows below for a:

- Standard system
- Distributed system or high-availability system

**Standard System**

To perform the export for a standard system, proceed as follows on the standard system host:

1. Perform the export on the **standard system host**:
   
   1. Run SAPinst on UNIX or Windows [page 19] or on System i [page 22] to export the database instance.
      
      In SAPinst choose the system copy option **Database Instance Export**.

      **CAUTION**

      If your database instance is running on HP PA-Risc, you must proceed as described in SAP Note 884452.

   
   **Result**

   You have finished this part of the system copy. To complete the system copy, perform the steps in Setting Up the Target System Using SAPinst [page 27].

**Distributed System or High-Availability System**

To perform the export for a **distributed system** or a **high-availability system**, proceed as follows:

1. Perform the export on the **database instance host**:
   
   1. Run SAPinst on UNIX or Windows [page 19] or on System i [page 22] to export the database instance.
In SAPinst choose the system copy option **Database Instance Export**.

**CAUTION**

If your database instance is running on HP PA-Risc, you need to proceed as described in SAP Note 884452.

Result

You finished this part of the system copy. To complete the system copy, perform the steps as described in Setting Up the Target System Using SAPinst [page 27].

### 4.2 Exporting the Source System Using SAPinst

Here you can find information about how to run SAPinst to perform the export on the source system:

- Running SAPinst on UNIX or Windows to Perform the Export [page 19]
- Running SAPinst on System i to Perform the Export [page 22]

#### 4.2.1 Running SAPinst on UNIX or Windows to Perform the Export

This procedure tells you how to run SAPinst to export the database of your SAP system. SAPinst includes a SAPinst GUI and a GUI server, which both use Java.

This section describes a standard export where SAPinst, SAPinst GUI, and the GUI server are running on the same host. If required, you can instead perform a remote system copy SAPinst [page 81], where SAPinst GUI is running on a separate host from SAPinst and the GUI server.

**Prerequisites**

- You are logged on to your host as user root.

**CAUTION**

Make sure that this user has not set any environment variables for a different SAP system or database.

- You are logged on to your host as user with the required rights and privileges that authorize you to install the SAP system with the SAPinst tool. For more information, see section Required User Authorization for the Installation in your installation guide.

- Make available the Master Installation DVD.
You need at least 60 MB of free space in the installation directory for each ABAP installation option, and at least 130 MB of free space in the installation directory for each Java installation option. In addition, you need 60-200 MB free space for the SAPinst executables.

If you cannot provide 200 MB free space in the temporary directory, you can set one of the environment variables TEMP, TMP, or TMPDIR to another directory with 200 MB free space for the SAPinst executables.

For more information about SAPinst, see Useful Information About SAPinst [page 76].

CAUTION
We recommend that you shut down the SAP system before the export. The database must still be running. Otherwise, the target system might be inconsistent.

Procedure

1. Start SAPinst from the SAP Installation Master DVD as follows:

   Start SAPinst in one of the following ways:
   - Using the default installation directory (recommended)
     Enter the following commands:
     ```
     cd <Installation_Master_DVD>/IM_<OS> ./sapinst
     ```
     SAPinst creates a directory called sapinst_instdir, which is the current working directory for your installation, below the temporary directory of your operating system.
   - Using an alternative installation directory
     If you want to use an alternative installation directory, set the environment variable TEMP, TMP, or TMPDIR.
   - Make sure that your operating system does not delete the contents of the temporary directory /tmp or the contents of the directories to which the variables TEMP, TMP, or TMPDIR point, for example, by using a crontab entry.
   - Make sure that your current working directory is not an IM_<OS> directory belonging to another operating system.

   EXAMPLE
   For example, the following causes an error:
   ```
   $ cd /sapcd2/IM_HPUX_IA64
   $ /sapcd2/IM_HPUX_PARISC/sapinst
   ```
   To correct this enter the following:
   ```
   $ cd /sapcd2/IM_HPUX_PARISC
   $ /sapcd2/IM_HPUX_PARISC/sapinst
   ```
Database Independent System Copy

4.2 Exporting the Source System Using SAPinst

Only valid for: Windows

Double-click `sapinst.exe` from the following path:

`<DVD_drive>:\DATA_UNITS\IM_WINDOWS_<platform>`

End of: Windows

SAPInst GUI normally starts automatically by displaying the Welcome screen.

2. On the Welcome screen, choose `Software Life-Cycle Options` → `System Copy` → `<database>` → `<Source System` → `<Distribution option>" → `Based on `<technical stack>`.

3. Select the corresponding system copy option from the tree structure according to the sequence of the process flow for the `database-independent system copy procedure` [page 17].

**CAUTION**

Make sure that you choose the system copy options exactly in the order they appear for each system variant.

The following table provides an overview about the available installation options available for the export:

<table>
<thead>
<tr>
<th>Export Option</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Database Instance Export</td>
<td>Mandatory step. SAPInst performs the following steps:</td>
</tr>
<tr>
<td></td>
<td>■ Creates the export directory structure with label files</td>
</tr>
<tr>
<td></td>
<td>■ Creates database structure files (*STR)</td>
</tr>
<tr>
<td></td>
<td>■ Updates database statistics</td>
</tr>
<tr>
<td></td>
<td>■ Calculates the size of the target database (*EXT, DBSIZE.XML)</td>
</tr>
<tr>
<td></td>
<td>■ Exports the database content</td>
</tr>
</tbody>
</table>

4. After you have selected the required option, choose Next.

Only valid for: UNIX

**CAUTION**

If your database instance is running on HP PA-Risc, you must proceed as described in SAP Note 884452.

End of: UNIX

5. Follow the instructions in the SAPInst input dialogs and enter the required parameters.

**CAUTION**

You must choose `Typical` when performing a system copy with database tools.

**NOTE**

For more information about input parameters in SAPInst, position the cursor on the parameter field and choose `F1`.

After you have entered all required input parameters, SAPInst starts the export and displays the progress during the processing phase.
4.2.2 Running SAPinst on System i to Perform the Export

4.2.2.1 Starting SAPinst on System i

**CAUTION**
We recommend that you shut down the SAP system before the export. Otherwise, the target system might be inconsistent.

This procedure tells you how to run SAPinst to export the database of your SAP system. SAPinst includes an SAPinst GUI and a GUI server, which both use Java.
This section describes an export where SAPinst and SAPinst GUI server runs on the i5/OS host and the GUI runs on a Windows 32-bit host.

**NOTE**
When you start SAPinst, the GUI server is also started. SAPinst GUI connects using a secure SSL connection to the GUI server and the GUI server connects to SAPinst.

**Procedure**

1. Log on your host as a user with similar authorization rights as QSECOFR. For more information, see Preparing a System i User Profile [page 24].

   **CAUTION**
   Make sure that the installation user has not set any environment variables for a different SAP system or database.

2. Make available the Installation Master DVD.
   For more information about making the DVDs available, see Copying the DVDs Manually Using the ROOTBIN Share [page 25].

3. Start SAPinst from the SAP Installation Master DVD in one of the following ways:
   - Using the default installation directory (recommended)
     Enter the following commands:
     
       `cd '<Installation_Master_DVD>/DATA_UNITS/IM_OS400_PPC64_DB4'
       CALL PGM(QP2TERM) PARM('./sapinst')`

     **NOTE**
     As a default, there is no GUI on System i, so you cannot see an SAPinst Welcome screen. You must start the SAPinst GUI separately on a Windows 32-bit platform. For more information, see Starting SAPinst GUI Separately (Optional) [page 85].
NOTE

For advanced users only: PASE, which is similar to AIX allows you to set the DISPLAY variable. If you already have a running and configured XWindows Server on Linux or Windows (for example Humming Bird), you can try to direct the graphical output of SAPinst to a XWindow by setting the DISPLAY variable. If this works, you do not have to use the remote SAPinst GUI separately. We do not recommend that you start the SAPinst using the DISPLAY variable as there is no support available.

NOTE

If you are installing a high-availability system and you have not already set the environment parameter SAPINST_USE_HOSTNAME to specify the virtual host name, you can start SAPinst as follows:

CALL PGM(QP2TERM) PARM('./sapinst ' 'SAPINST_USE_HOSTNAME=<virtual host name>')

CAUTION

Make sure that your operating system does not delete the contents of the temporary directory /tmp or the contents of the directories to which the variables TEMP, TMP, or TMPDIR point.

CAUTION

Make sure that your current working directory is not an IM_<OS> directory belonging to another operating system.
For example, the following commands are incorrect and cause an error:

$ CD DIR ('/sapcd2/IM_HPUX_IA64')
$ CALL PGM(QP2TERM) PARM('/sapcd2/IM_HPUX_PARISC/sapinst')

The following commands are correct:

$ CD DIR('/sapcd2/IM_OS400_PPC64_DB4')
$ CALL PGM(QP2TERM) PARM('./sapinst')

Using an alternative installation directory

If you want to use an alternative installation directory, set the environment variable TEMP, TMP, or TMPDIR.

NOTE

To get a list of all available SAPinst properties, enter the following command:

CALL PGM(QP2TERM) PARM('./sapinst -p')

4. On the Welcome screen, choose Software Life-Cycle Options → System Copy → <database> → Source System → <Distribution option> → Based on <technical stack>.

5. Select the corresponding system copy option from the tree structure according to the sequence of the process flow for the Database-independent system copy procedure [page 17]:

4 Database Independent System Copy
4.2 Exporting the Source System Using SAPinst
4.2 Exporting the Source System Using SAPinst

**CAUTION**
Make sure that you choose the system copy options exactly in the order they appear for each system variant.

6. The following table provides an overview about the available system copy options available for the export of a:
   - Central system
   - Distributed system or high-availability system

Export Options

<table>
<thead>
<tr>
<th>Export Option</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Database Instance Export</td>
<td>Mandatory step. SAPinst performs the following steps:</td>
</tr>
<tr>
<td></td>
<td>Creates the export directory structure with label files</td>
</tr>
<tr>
<td></td>
<td>Creates database structure files (*STR)</td>
</tr>
<tr>
<td></td>
<td>Updates database statistics</td>
</tr>
<tr>
<td></td>
<td>Calculates the size of the target database (*EXT, DBSIZE.XML)</td>
</tr>
<tr>
<td></td>
<td>Exports the database content</td>
</tr>
</tbody>
</table>

7. After you have selected the required installation option, choose Next.

**CAUTION**
If your database instance is running on HP PA-Risc, you must proceed as described in SAP Note 884452.

8. Follow the instructions in the SAPinst input dialogs and enter the required parameters.

**CAUTION**
You must choose Typical when performing a system copy with database tools.

**NOTE**
For more information about input parameters in SAPinst, position the cursor on the parameter field and choose F1.

After you have entered all required input parameters, SAPinst starts the export and displays the progress during the processing phase.

**Troubleshooting**
See Useful Information About SAPinst [page 76].

Only valid for: IBM i5/OS | IBM i5/OS | IBM DB2 for i5/OS |

---

4.2.2.2 Preparing a System i User Profile

For the installation you need to create a user account on the System i you want to install. The following requirement apply:
The System i user profile must have user class *SECOFR and all special authorities that belong to user QSECOFR.

**Procedure**

**NOTE**
The user name SAPINSTUSR and the password SAP are used in the procedures as examples.

**System i:**
Execute the following command:

```plaintext
CRTUSRPRF USRPRF(SAPINSTUSR) PASSWORD(SAP) USRCLS(*SECOFR) TEXT('Test User for SAP Installation') SPCAUT(*USRCLS) LANGID(ENU) CNTRYID(US) CCSID(500)
```

**NOTE**
In previous releases, we recommended that you create the user SAPINST to install the SAP system. In the current release, a group SAPINST is created and used for the installation and SAP system. If a user SAPINST already exists on your system, you must delete this user.

**CAUTION**
You should not set the system variable QIBM_PASE_CCSID. You should leave this variable empty!

---

### 4.2.2.3 Copying the DVDs Manually Using the ROOTBIN Share

**Procedure**

**NOTE**
We use the user name SAPINSTUSR and the password SAP as examples.

**NOTE**
This is a secure way to copy DVDs manually into the IFS of your System i.

**NOTE**
When you make the DVDs available locally, make sure that the content is copied correctly. For example, the content might become corrupted by copying using a converting share or long file names can be shortened.

1. **If you do not already have a binary share ROOTBIN on your System i, you have to create this share manually using the iSeries Navigator (OpsNav).**

**CAUTION**
This is normally done by a System i administrator!
1. Start the iSeries Navigator on your Windows PC.
2. Connect to your System i using My Connections.
3. To create or change the share ROOTBIN choose File Systems → File Shares.
5. A new screen iSeries Netserver appears. Click the folder Shared Objects to see the shares.
6. To check the already existing share ROOTBIN or create a new share ROOTBIN, right-click New File.
7. The share ROOTBIN should have the access permission Read/Write and the Path name should be /.
8. On the Text Conversion tab, do not select Allow file text conversion.
9. To save the share ROOTBIN press OK.

Now you have created a share ROOTBIN on your System i.

To open the MS DOS screen on Windows, choose Start → Run.

3. Enter cmd.exe.
4. Press OK.

The MS DOS screen appears.

5. In the command line of the MS DOS screen, enter net use.

All network connections to shared resources are displayed.

6. Check if you have a connection to your System i.

If you find \<System_i_Hostname>\ROOTBIN in the column Remote and a drive directory letter in the column Local, you have already established the required connection to your System i. Otherwise, you have to establish this connection. To do this, enter:

```bash
net use X: \<System_i_Hostname>\ROOTBIN SAP /USER:SAPINSTUSR
```

X: is now your new network drive to share \<System_i_Hostname>\ROOTBIN to your IFS on the System i. If X: is already in use, choose another drive letter that is free.

For more information, see Preparing a System i User Profile [page 24].

7. To change to the new network drive, enter X: in the command line of your MS DOS screen.

8. Create the subdirectories in your IFS where you want to copy the required DVDs.

For each DVD, enter:

```bash
mkdir /tmp/<sid>/<DVD_name>
```

**NOTE**

You should avoid spaces in the DVD path name.

9. Copy the installation DVDs from your Windows drive (for example D:\) to the IFS of your System i host. Insert the required installation DVDs and enter the following command:

For each DVD, enter:

```bash
xcopy D:\<DVD> X: /tmp/<sid>/<DVD_name> /E
```
NOTE
You have to copy the root directory of the DVD and all required DVD subdirectories to the IFS of your System i.

10. For each required DVD, create a subdirectory and copy the required DVDs.

4.3 Setting Up the Target System

Purpose
You use SAPinst to install the target system and import the database files that you have exported from the source system.

Process Flow

Standard System
You perform the following steps on the standard system host:
1. You prepare the standard system host for the installation of your target system as described in the installation guide for your SAP application.
2. You transfer the Java export files to the central system target host [page 28].
3. You install the target system [page 28].
4. If required, on the host(s) of the application server instance, you install further additional application server instance(s) as described in the installation guide for your SAP application.

Distributed System or High-Availability System
Perform the following steps on the relevant installation hosts of your target system:
1. You prepare the central services instance host, the database instance host and the host of the primary application server instance for the installation of the corresponding instances of your target system as described in the installation guide for your SAP application.
2. You install the central services instance for the target system as described in the installation guide for your SAP application.
3. You perform the following steps on the database instance host:
   1. You transfer the Java export files to the database instance target host [page 28].
   2. You install the database instance of the target system [page 28].
4. On the host of the primary application server instance, you install the primary application server instance of the target system.
5. If required, on the host(s) of the additional application server instance, you install further additional application server instance(s) as described in the installation guide for your SAP application.
4.3.1 Transferring the Export Files to the Target Host

Procedure
1. On the target host, create a directory `<EXPDIR>` with sufficient space for the database export files available.
2. Copy all files and directories (recursively) that are located on the source host in the migration export directory `<EXPDIR>` from the source host to the target host.
   
   **NOTE**
   If you transfer the files with file transfer protocol (ftp), make sure that you use binary mode for transferring the files.
3. Check the permissions of the transferred files on the target host. All files have to be accessible for user `<sapsid>adm` of the target system.

4.3.2 Installing the Target System

Prerequisites
There is enough free space on the target system for the database load.
To find out the size of the export and the sizes of the tablespaces or dbspaces that will be created, look at the file `DBSIZE.XML`, which is located in the following directory:

**Only valid for: Windows**

```
<DRIVE>:\<EXPDIR>\DB\<DATABASE>
```

End of: Windows

**Only valid for: UNIX**

```
<EXPDIR>/DB/<DATABASE>
```

End of: UNIX

Procedure
1. Prepare the target system host as described in the installation guide for your SAP system.
2. Start SAPinst as described in the installation guide for your SAP system.
3. On the Welcome screen of the SAP Installation Master DVD, navigate to the following folder according to the requirements of your target system: `<SAP System> Software Life-Cycle Options System Copy Target System <system variant> Based on <technical stack>`.
4. Run the option(s) required for your system copy in the sequence they are listed in the specific folder and according to the process flow in Setting Up the Target System Using SAPinst [page 27].
5. To install the target system, follow the instructions in the SAPinst input dialogs and enter the required parameters on the screen SAP System Database - Select the Database Copy Method. On this screen, choose Standard System Copy/Migration (Load-Based).

The SAP data dump from the MIGRATION EXPORT CD image that you created during the export is loaded in the newly installed SAP system database.
4 Database Independent System Copy

4.3 Setting Up the Target System

CAUTION

- Do not create the installation directory (for example: sapinst_instdir) in the following directories:
  - UNIX: /usr/sap/<SAPSID>
  - UNIX: /sapmnt/<SAPSID>
  - Windows: \usr\sap\<SAPSID>
  - Windows: \sapmnt\<SAPSID>

- If you perform a Unicode conversion, the data import into the target system might abort because of missing space in the database tablespace or dbspace. Enlarge the database or database container, in which the table DYNPSOURCE will be created in the target database. The required size for the table will be fifteen times larger than in the non-Unicode source system.

6. When SAPinst displays the Media Browser window and asks for the Export Migration CD, enter the path to the export directory <EXPDIR>.

7. If you perform a heterogeneous system copy, enter the Migration Key on the screen Database Import.

8. Complete the installation as described in the installation documentation for your SAP component.

NOTE

- If you have to restart the import after an error, just restart SAPinst. The import continues with the table that has not yet been successfully imported.

NOTE

- The Java EE engine is not started automatically. After the target system has been installed and the follow-up activities [page 71] have been performed, you have to start the Java EE engine manually.
5  Database-Specific System Copy

The following sections describe the database-specific methods for the homogeneous system copy. For more information about SAP Notes describing the homogeneous system copy for your database system, see http://service.sap.com/notes.

Process
Follow the sequence of steps described in the process flows below for a:
- Central system
- Distributed system
- High-availability system

Central System
For performing the export for a central system, you need to proceed as follows on the central system host:

Process Flow on the Source System (Export)
1. You generate the control file structure for the target database [page 33].
2. If required, you create an offline backup of the source database [page 38].

Process Flow on the Target System
1. **Only valid for: Windows |**
   You install the database software as described in the installation guide of your SAP solution.
   
   End of: Windows |

2. **Only valid for: UNIX |**
   You prepare the target system [page 38]:
   1. Follow the instructions on the SAPinst screens until SAPinst requests you to install the database software and to perform the database backup/restore.
   2. You create the database file system (if not yet existing).
   3. You install the database software.

   End of: UNIX |

3. **Only valid for: Windows |**
   Follow the instructions on the SAPinst screens until you are requested to perform the database backup/restore.

   **NOTE**
   If required, you have to restart SAPinst as described in the installation guide of your SAP solution.

   End of: Windows |
4. To complete the system copy, you have to perform the follow-up activities [page 71].

**Distributed System or High Availability System**

To perform the export for a distributed or high-availability system, proceed as follows:

**Process Flow on the Source System (Export)**

1. On the database instance host of the source system, you generate the control file structure for the target database [page 33].
2. If required, on the database instance host, you create an offline backup of the source database [page 38].

**Process Flow on the Target System**

1. Only valid for: Windows |
   On the database instance host, you install the database software as described in the installation guide of your SAP solution.
   
   End of: Windows |

2. Only valid for: UNIX |
   You prepare the target system [page 38]:
   
   1. On the database instance host, follow the instructions on the SAPinst screens until SAPinst requests you to install the database software and to perform the database backup/restore.
   2. On the database instance host, you create the database file system (if not yet existing).
   3. On the database instance host, you install the database software.

   End of: UNIX |

3. Only valid for: Windows |
   On the database instance host, follow the instructions on the SAPinst screens until you are requested to perform the database backup/restore.

   **NOTE**
   If required, you have to restart SAPinst as described in the installation guide of your SAP solution.

   End of: Windows |

4. To complete the system copy, you have to perform the follow-up activities [page 71].

   Only valid for: Oracle |

**5.1 Oracle-Specific Procedure**

**Purpose**

In an SAP system environment, you can create a homogeneous copy of an Oracle database by copying database files. This method is suitable for creating an exact copy of an existing database. The source of the copy can be an offline backup or the file system of your source host.

You use SAPinst for the installation on the target system host as described in the installation documentation for your SAP component. Only the SAPinst steps for setting up and loading the database steps are different.
Advantages

- You can use existing offline backups (provided that redo logs were cleaned up with forced log switches).
- This method is faster than the Jload method.

Disadvantages

- Offline backup/copy of database files in a heterogeneous environment is not possible because the hardware of the source and target systems must be binary-compatible.
- Source system host and target system host must be different.
- You must shut down the SAP system and the database during offline backup/copy of database files.
- You cannot change the database schema and the tablespace names.

Prerequisites

- You must use the same Oracle release and patch level for your database in the source and target system.
- The \texttt{classes12.jar} must exist in the \texttt{<ORACLE_HOME>/jdbc/lib} directory (installed using a standard Oracle installation).
- The backup must be done offline.

\textbf{NOTE}

- The system copy procedure does not support the usage of an online backup to copy your Java engine.
- The source and target systems must run on different hosts for security reasons.
- The source and target systems must be binary compatible.

\textbf{NOTE}

- Note that you can also perform a system copy from 32-bit systems to 64-bit systems and vice versa (same operating system assumed) even if source and target system are not binary compatible.

If your source system uses the US7ASCII character set, you must choose this character set when installing the target system. SAPinst prompts for the character set during the installation (key: \texttt{Database Character Set}). The installation default is \texttt{WE8DEC} or \texttt{UTF8} for Unicode systems. To find out the character set used by the source system, connect to the source database as user \texttt{sap<schemaid>} or \texttt{sapr3} with \texttt{sqlplus} and enter: \texttt{SELECT * FROM V$NLS_PARAMETERS;}

5.1.1 Generating the Control File Structure

The \texttt{OraBRCopy} Java tool writes a file \texttt{CONTROL.SQL} to the current working directory, which can be used without further adaptions on the target system.

For more information about the \texttt{OraBRCopy} tool, see the documentation \texttt{ORABRCopy.pdf}, which is part of the \texttt{OraBRCOPY.SAR} archive.
Prerequisites

**RECOMMENDATION**

We recommend that you shut down the SAP system before you perform the following steps. The database must still be running.

Procedure

1. Create an installation directory `<INSTDIR>` (UNIX: with permissions 777) on the source system.
2. Copy the `ORABRCOPY.SAR` archive from the *SAP Installation Master DVD* to the installation directory and extract it using `SAPCAR`.
   
   You can find the archive in the following directory on the *Installation Master DVD*:
   
   ```plaintext
   <DVD-DIR>:/DATA_UNITS/IM_<OS_platform>/COMMON/INSTALL/ORA/ORABRCOPY.SAR
   End of: UNIX |
   Only valid for: Windows |
   <DVD-DIR>:\DATA_UNITS\IM_<OS_platform>\COMMON\INSTALL\ORA\ORABRCOPY.SAR
   End of: Windows |
   ```
3. Make sure that all redo log groups are archived
4. Start the *OraBRCopy* tool as an OS user with Oracle DBA privileges:
   
   ```plaintext
   user ora<dbsid>
   user <sapsid>adm
   ```
5. Enter the following commands:
   
   ```plaintext
   Only valid for: UNIX |
   ./ora_br_copy.sh -generateFiles -forceLogSwitches -targetSid <TARGET_DBSID> -
   password <system's password> -listenerPort <listener port>
   ```
   ```plaintext
   Only valid for: Windows |
   ora_br_copy.bat -generateFiles -forceLogSwitches -targetSid <TARGET_DBSID> -
   password <system's password> -listenerPort <listener port>
   ```
   
   The tool creates the files `CONTROL.SQL`, `CONTROL.TRC`, and `init<targetSID>.ora` in your installation directory, shuts down and restarts the database and performs the required log switches.

   **NOTE**

   If an error occurs, check the log file:
   ```plaintext
   <INSTDIR>/ora.br_copy.log
   ```
6. Verify and, if necessary, update the `CONTROL.SQL` control file using the `CONTROL.TRC` trace file as follows.

   **Example**

   In the following example, entries of `CONTROL.SQL` written in bold should be compared to the trace file. This is a Windows example, however, the changes to be made are valid for UNIX, too.

   ```plaintext
   REM
   ```
REM CONTROL.SQL
REM
REM SAP AG Walldorf
REM Systeme, Anwendungen und Produkte in der Datenverarbeitung
REM
REM (C) Copyright SAP AG 2006
REM
REM Generated at:
REM Fri Sep 17 08:33:25 CEST 2006
REM for target system NEW
REM on
REM Windows 2000 5.0 x86
CONNECT / AS SYSDBA
STARTUP NOMOUNT
CREATE CONTROLFILE REUSE
SET DATABASE "NEW"
RESETLOGS
ARCHIVELOG
MAXLOGFILES 255
MAXLOGMEMBERS 3
MAXDATAFILES 1022
MAXINSTANCES 50
MAXLOGHISTORY 1134
LOGFILE
GROUP 1 (  
'D:\ORACLE\NEW\ORIGLOGA\LOG_G11M1.DBF',  
'D:\ORACLE\NEW\MIRRLOGA\LOG_G11M2.DBF'
  ) SIZE 50M,
GROUP 2 (  
'D:\ORACLE\NEW\ORIGLOGB\LOG_G12M1.DBF',  
'D:\ORACLE\NEW\MIRRLOGB\LOG_G12M2.DBF'
  ) SIZE 50M,
GROUP 3 (  
'D:\ORACLE\NEW\ORIGLOGA\LOG_G13M1.DBF',  
'D:\ORACLE\NEW\MIRRLOGA\LOG_G13M2.DBF'
  ) SIZE 50M,
GROUP 4 (
  'D:\ORACLE\NEW\ORIGLOGB\LOG_G14M1.DBF',
  'D:\ORACLE\NEW\MIRRLOGB\LOG_G14M2.DBF'
) SIZE 50M
DATAFILE
  'D:\ORACLE\NEW\SAPDATA1\SYSTEM_1\SYSTEM_DATA1',
  'D:\ORACLE\NEW\SAPDATA3\IMS_1\IMS_DATA1',
  'D:\ORACLE\NEW\SAPDATA3\IMS_2\IMS_DATA2',
  'D:\ORACLE\NEW\SAPDATA3\IMS_3\IMS_DATA3',
  'D:\ORACLE\NEW\SAPDATA3\IMS_4\IMS_DATA4',
  'D:\ORACLE\NEW\SAPDATA4\IMS_5\IMS_DATA5',
  'D:\ORACLE\NEW\SAPDATA4\IMS_6\IMS_DATA6',
  'D:\ORACLE\NEW\SAPDATA4\IMS_7\IMS_DATA7',
  'D:\ORACLE\NEW\SAPDATA4\IMS_8\IMS_DATA8',
  'D:\ORACLE\NEW\SAPDATA4\IMS_9\IMS_DATA9',
  'D:\ORACLE\NEW\SAPDATA1\IMS700_1\IMS700_DATA1',
  'D:\ORACLE\NEW\SAPDATA1\IMS700_2\IMS700_DATA2',
  'D:\ORACLE\NEW\SAPDATA1\IMS700_3\IMS700_DATA3',
  'D:\ORACLE\NEW\SAPDATA1\IMS700_4\IMS700_DATA4',
  'D:\ORACLE\NEW\SAPDATA2\IMS700_5\IMS700_DATA5',
  'D:\ORACLE\NEW\SAPDATA2\IMS700_6\IMS700_DATA6',
  'D:\ORACLE\NEW\SAPDATA2\IMS700_7\IMS700_DATA7',
  'D:\ORACLE\NEW\SAPDATA2\IMS700_8\IMS700_DATA8',
  'D:\ORACLE\NEW\SAPDATA2\IMS700_9\IMS700_DATA9',
  'D:\ORACLE\NEW\SAPDATA3\IMS700_10\IMS700_DATA10',
  'D:\ORACLE\NEW\SAPDATA4\IMS700_11\IMS700_DATA11',
  'D:\ORACLE\NEW\SAPDATA1\IMSUSR_1\IMSUSR_DATA1',
  'D:\ORACLE\NEW\SAPDATA2\ROLL_1\ROLL_DATA1'
);
ALTER DATABASE OPEN RESETLOGS;
ALTER TABLESPACE PSAPTEMP ADD TEMPFILE
  'D:\ORACLE\NEW\SAPDATA3\TEMP_1\TEMP_DATA1'
SIZE 350M REUSE AUTOEXTEND OFF;

Changes to Be Made
1. If you want to migrate your database from 32-bit to 64-bit or vice-versa, add the following lines at
   the bottom of the control.sql file:
     shutdown immediate;
startup upgrade
spool utlirp.log
@?/rdbms/admin/utlirp.sql
spool off
shutdown immediate;
startup
exit

2. **MAXLOGFILES 255**
   ...
   The numbers must be greater than or equal to the corresponding numbers in the trace file.

3. **GROUP 1**
   
   'D:\ORACLE\NEW\ORIGLOGA\LOG_G11M1.DBF',
   'D:\ORACLE\NEW\MIRRLOGA\LOG_G11M2.DBF'
   ) SIZE 50M,

   Group 2
   ...
   The sizes of the respective groups must be equal to the sizes of the corresponding groups in the trace file.

4. 'D:\ORACLE\NEW\SAPDATA1\SYSTEM_1\SYSTEM\DATA1',
   'D:\ORACLE\NEW\SAPDATA3\IMS_1\IMS\DATA1',
   ...
   'D:\ORACLE\NEW\SAPDATA1\IMS700_1\IMS700\DATA1'
   ...
   The count of the data files must be equal to the count of the corresponding data files in the trace file.

5. **ALTER TABLESPACE PSAPTEMP ADD TEMPFILE**
   
   'D:\ORACLE\NEW\SAPDATA3\TEMP_1\TEMP\DATA1'
   SIZE 350M REUSE AUTOEXTEND OFF;
   ...
   The size must be equal to the corresponding size in the trace file.

6. The number of the rows with **ALTER TABLESPACE** must be equal to the number of the corresponding rows in the trace file.

### 5.1.2 Creating a Backup

If required, create a backup. Choose between performing an offline backup manually or an online backup with BR*Tools.
5.1.2.1 Creating an Offline Backup

Procedure

If required, create an offline backup. There are different possibilities for preparing the actual transfer of the database files:

- If you have an up-to-date offline backup, you can use it (provided that redo logs were cleaned up with forced log switches).
- If you want to transport the database file (for example, on tape) or if you have to perform the database shutdown at a certain time, stop the database (normal shutdown) and perform a complete offline backup. You can use the trace file CONTROL.TRC created by OraBrCOPY to determine the file system trees that have to be saved.
- You stop the database (normal shutdown) and copy the database files when the actual transfer to the target system takes place. You do not have to perform any preparations for the actual transfer now.

5.1.2.2 Creating an Offline or Online Backup with BR*Tools

You can use any backup strategy supported by BR*Tools as the basis for a system copy: offline or online, with or without BACKINT, with or without RMAN, complete or incremental, and so on. The backup strategy must simply be valid for restore and recovery. This means that a complete restore and recovery of the source database must be possible. In addition for BACKINT and RMAN, the external backup tools must be configured so that a restore is possible on the target host.

Procedure

⚠️ CAUTION

To ensure that no changes are made to the file system during backup, stop the Software Deployment Manager (SDM).

Proceed as described in the SAP Library [page 8] at:


5.1.3 Preparing the Target System (Oracle)

Prerequisites

Make sure that sapdata<n> file systems on the target system host are large enough.
Procedure

1. Install the target SAP system with SAPinst as described in the installation documentation for your SAP solution.

   **CAUTION**

   When you perform a system copy with the Oracle backup/restore method, you cannot change the database schema and the tablespace names of the new target system. When installing the target primary application server instance, the target database instance, or the target additional application server instance make sure that you enter the correct database schema names (which are the database schema names of the source system). The schema names of the source and target system must be identical.

2. On the Welcome screen, choose:
   
   ![<SAP system> → Software Life-Cycle Options → System Copy → Target System → <system variant>] [4].

3. When SAPinst prompts for the database copy method, choose Homogeneous System Copy (Backup/Restore).

4. Proceed until SAPinst stops to restore the database files on the target system.

   The following message is displayed:

   SAPinst now stops the installation. Please proceed as follows:...

5. Only valid for: UNIX |

   If necessary, extract the Oracle stage archives manually and install the Oracle software as described in the installation documentation for your SAP solution.

   End of: UNIX |

6. Restore the database files on the target system.

7. If they do not exist, create the following directories on the target system:

   Only valid for: UNIX |

   **UNIX:**

   - /oracle/<TARGET_DBSID>/mirrlog<x>
   - /oracle/<TARGET_DBSID>/origlog<x>
   - /oracle/<TARGET_DBSID>/sapdata<x>
   - /oracle/<TARGET_DBSID>/sapreorg
   - /oracle/<TARGET_DBSID>/saparch
   - /oracle/<TARGET_DBSID>/oraarch
   - /oracle/<TARGET_DBSID>/saptrace
   - /oracle/<TARGET_DBSID>/saptrace/background
   - /oracle/<TARGET_DBSID>/saptrace/usertrace
   - /oracle/<TARGET_DBSID>/origlogA/cntrl
   - /oracle/<TARGET_DBSID>/sapdata1/cntrl
   - /oracle/<TARGET_DBSID>/saparch/cntrl
   - /oracle/<TARGET_DBSID>/sapcheck

   End of: UNIX |
5. Make sure that the following directories are empty (except the subdirectory saparch/cntrl):

5.1 Oracle-Specific Procedure

- **Windows:**
  - `<drive>:\oracle\<TARGET_DBSID\>\mirrlog\x`
  - `<drive>:\oracle\<TARGET_DBSID\>\origlog\x`
  - `<drive>:\oracle\<TARGET_DBSID\>\sapdata\x`
  - `<drive>:\oracle\<TARGET_DBSID\>\sapreorg`
  - `<drive>:\oracle\<TARGET_DBSID\>\saparch`
  - `<drive>:\oracle\<TARGET_DBSID\>\oraarch`
  - `<drive>:\oracle\<TARGET_DBSID\>\saptrace`
  - `<drive>:\oracle\<TARGET_DBSID\>\saptrace\background`
  - `<drive>:\oracle\<TARGET_DBSID\>\saptrace\usertrace`
  - `<drive>:\oracle\<TARGET_DBSID\>\origlogA\cntrl`
  - `<drive>:\oracle\<TARGET_DBSID\>\sapdata1\cntrl`
  - `<drive>:\oracle\<TARGET_DBSID\>\saparch\cntrl`
  - `<drive>:\oracle\<TARGET_DBSID\>\sapcheck`

- **UNIX:**
  - `/oracle/<TARGET_DBSID>/saparch`
  - `/oracle/<TARGET_DBSID>/oraarch`

6. All directories must be owned by the user `ora<target_dbsid>`.

   To achieve this enter the following command:

   ```sh
cmow ora<target_dbsid>:dba<directory>
   ```

7. Set the security settings for the built-in accounts and groups `SYSTEM`, `Administrators`, `SAP_<SAPSID>_GlobalAdmin` (domain installation), and `SAP_<SAPSID>_LocalAdmin` (local installation) for all directories as follows:

   1. In the Windows Explorer, right-click the Oracle root directory and choose Properties.
   3. Deselect Inherit from parent the permission entries....
4. In the next dialog, choose Copy to copy the permission entries that were previously applied from the parent to this object.
5. Choose OK.
6. Set the permissions for the above-mentioned accounts SYSTEM, Administrators, SAP_<DBSID>_GlobalAdmin, or SAP_<DBSID>_LocalAdmin to Full Control.
7. Delete all other accounts.

5.1.4 Restoring the Database Files on the Target System

CAUTION

If you do not use an offline backup but copy the database files directly from the source to the target system host, make sure that you shut down the database on the source system before you copy the listed files from the source to the target directories.

Procedure

1. Copy the following files from the source to the target system host either by using an offline backup or by copying the listed files from the source directories to the target directories.

Directories on UNIX

<table>
<thead>
<tr>
<th>Source and Target Directory</th>
<th>Files</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>/oracle/&lt;DBSID&gt;/sapdata&lt;x&gt;</code></td>
<td>All files</td>
</tr>
<tr>
<td><code>/oracle/&lt;DBSID&gt;/origlog&lt;x&gt;</code></td>
<td>All files</td>
</tr>
<tr>
<td><code>/oracle/&lt;DBSID&gt;/mirrlog&lt;x&gt;</code></td>
<td>All files</td>
</tr>
<tr>
<td>source: &lt;INSTDIR&gt;</td>
<td></td>
</tr>
<tr>
<td>target: &lt;SAPINST_INSTDIR&gt;</td>
<td>CONTROL.SQL</td>
</tr>
<tr>
<td>source: &lt;INSTDIR&gt;</td>
<td>init&lt;TARGET_DBSID&gt;.ora</td>
</tr>
<tr>
<td>target: <code>/oracle/&lt;DBSID&gt;/</code></td>
<td></td>
</tr>
<tr>
<td><code>&lt;DB_VERSION&gt;_&lt;BIT&gt;/dbs</code></td>
<td></td>
</tr>
</tbody>
</table>

Directories on Windows

<table>
<thead>
<tr>
<th>Source and Target Directory</th>
<th>Files</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>&lt;drive&gt;:\oracle\&lt;DBSID&gt;\sapdata&lt;x&gt;</code></td>
<td>All files</td>
</tr>
<tr>
<td><code>&lt;drive&gt;:\oracle\&lt;DBSID&gt;\origlog&lt;x&gt;</code></td>
<td>All files</td>
</tr>
<tr>
<td><code>&lt;drive&gt;:\oracle\&lt;DBSID&gt;\mirrlog&lt;x&gt;</code></td>
<td>All files</td>
</tr>
<tr>
<td>source: &lt;INSTDIR&gt;</td>
<td></td>
</tr>
<tr>
<td>target: &lt;SAPINST_INSTDIR&gt;</td>
<td>CONTROL.SQL</td>
</tr>
<tr>
<td>source: &lt;INSTDIR&gt;</td>
<td>init&lt;TARGET_DBSID&gt;.ora</td>
</tr>
<tr>
<td>target: <code>/oracle/&lt;DBSID&gt;</code></td>
<td></td>
</tr>
<tr>
<td><code>&lt;DB_VERSION&gt;_&lt;BIT&gt;/database</code></td>
<td></td>
</tr>
</tbody>
</table>

Only valid for: Windows |

NOTE

If you use an existing offline backup, the source data files and log files are not located in the directories shown in the table.
The installation directory of the target system is normally located in the directory:

```
%programfiles%\sapinst_instdir\<SAP_System_Name>\LM\ORA\COPY\ORA\SYSTEM\<system_variant>\<technical_stack>
```

2. After you have copied the database files, make sure that the files on the source and target system are not located in different directories or drives. If required, make the corresponding changes in the files control.sql and the init<DBSID>.ora.

3. Verify that the created directories and copied files have the owner ora<target_dbsid>, belong to the group dba, and have the permissions 740.

4. Make sure that the control files are not restored. If necessary, remove them.

   The file names are specified by the parameter control_files of the init<TARGET_DBSID>.ora file.

### 5.1.5 Restoring the Database Files on the Target System with BR*Tools

**Procedure**

1. Copy the following files from the source system host to the target system host by copying manually the listed files from the source directories to the target directories.

   **On UNIX:**

   **Source and Target Directories on UNIX**

<table>
<thead>
<tr>
<th>Source and Target Directory</th>
<th>Files</th>
</tr>
</thead>
<tbody>
<tr>
<td>Source: &lt;INSTDIR&gt;</td>
<td>CONTROL.SQL</td>
</tr>
<tr>
<td>Target: &lt;SAPINST_INSTDIR&gt;</td>
<td></td>
</tr>
<tr>
<td>Source: &lt;INSTDIR&gt;</td>
<td>init&lt;TARGET_DBSID&gt;.ora</td>
</tr>
<tr>
<td>Target: /oracle/&lt;DBSID&gt;/&lt;DB_VERSION&gt;_.&lt;BIT&gt;/dbs</td>
<td></td>
</tr>
</tbody>
</table>

   **On Windows:**

   **Source and Target Directories on Windows**

<table>
<thead>
<tr>
<th>Source and Target Directory</th>
<th>Files</th>
</tr>
</thead>
<tbody>
<tr>
<td>Source: &lt;INSTDIR&gt;</td>
<td>CONTROL.SQL</td>
</tr>
<tr>
<td>Target: &lt;SAPINST_INSTDIR&gt;</td>
<td></td>
</tr>
<tr>
<td>Source: &lt;INSTDIR&gt;</td>
<td>init&lt;TARGET_DBSID&gt;.ora</td>
</tr>
<tr>
<td>Target: %programfiles%\sapinst_instdir\NW04SR1\WEBAS_COPY\CENTRAL\ONE_HOST or %programfiles%\sapinst_instdir\NW04SR1\WEBAS_COPY\DISTRIBUTED\DB</td>
<td>database</td>
</tr>
</tbody>
</table>

2. Call the restore and recovery function of BR*Tools.

   If you follow these instructions, the prerequisites are normally fulfilled. The main prerequisite is that the corresponding BR*Tools logs (BRBACKUP detailed and summary log, BRARCHIVE summary log) are copied from the source to the target system. In addition, the postprocessing steps mentioned in the SAP Note [1003028](http://www.sap.com) are covered during the standard system copy procedure.
For more information about the execution of restore and recovery under the control of
**BRRECOVER** and the exact syntax of **BRRECOVER**, see the section *Homogeneous Database Copy* in SAP Note **1003028**.


3. Shut down the Oracle database instance as follows:

```
SYNTAX
sqlplus /nolog connect / as sysdba shutdown immediate exit
```

Only valid for: MaxDB | 3.2 MaxDB-Specific Procedure

In an SAP system environment, you can create a homogeneous copy of a MaxDB database by using the backup and restore method. This method is suitable for creating an exact copy of an existing database. The source of the copy is a complete data backup of your source database.

The SAPinst tool is used for the installation on the target system host as described in the installation documentation for your SAP solution. In SAPinst you select the backup and restore method as the database installation method. SAPinst stops before the database instance initialization and asks you to perform the recovery on the target database. After you have performed recovery and post-recovery activities you can continue the installation in SAPinst.

This description is not valid for the liveCache system copy.

**Advantage**

- You can use existing offline backups.
- This method is faster than the *database-independent method* [page 17].

**Disadvantage**

You can only copy between systems with the same byte order. For more information, see below.

**Prerequisites**

- **Byte order** – little-endian or big-endian
  
  You can use the backup and restore method to copy systems with the same byte order. That is, you can copy a system based on little-endian to another system based on little-endian. You can also copy a system based on big-endian to another system based on big-endian. Check [SAP Note 552464](http://help.sap.com/nw71) to find out which processor and operating system combination uses which byte order.

- **Data backup**
  
  You perform the **complete** data backup of your source database.

- **Recovery tool**
You are using the MaxDB Database Manager (DBMGUI) version 7.5.0 Build 12 or above.
You can find more information on DBMGUI here:
http://maxdb.sap.com/currentdoc/default.htm → Tools → Database Manager GUI

Database Software
The database software on the target host must have the same version as the software on the source host. The build number of the software version on the target host must be greater than or equal to the version on the source host.

Size of the data on the target system
The size of the target system must be greater than the used space on the source system. You can find the size of the used pages on the source system as follows:

dbmc1i -d <database_name> -u <dbm_user>,<password> -n <database_server> -u SQL sap_sid>,<password> sql_execute 'SELECT USEDPERM FROM SERVERDBSTATISTICS'

The result of this query is the amount of used space, expressed as the number of 8 KB pages. To get the used space in MB, divide this value by 128. When SAPinst prompts you, configure the database data volumes according to this value.

Process
1. You do the following on the source system:
   1. If you do not already have a suitable recent complete MaxDB backup, you create a complete data backup using the DBMGUI tool:
      DBMGUI → Backup → Backup Wizard → Complete
   2. You make the backup medium available on the target host.
2. You do the following on the target system:
   1. To install the new system you start SAPinst as follows:
      In the Welcome screen, choose <your SAP system> → Software Life-Cycle Options → System Copy → MaxDB → Target System → <system variant>.
      During the installation of the database instance, SAPinst stops before database initialization in the screen Perform Database Recovery and asks you to perform the data recovery.
   2. You start the data recovery wizard from DBMGUI
      1. You register your database instance in the DBMGUI
      2. You check the database instance in the admin state.
      3. You choose Recovery → Recovery with Initialization ...
      4. In type of recovery you select Restore a medium.
      5. You specify the backup medium.
      6. You start the restore procedure.

NOTE
The recovery wizard does not start the recovery immediately. It initializes the database instance first. It takes some time for the database server to format the database volumes.
3. After the restore, you check the state of the target database instance. Change the database state
to online if it is not already in online state.
4. You delete the entries from the following tables to make sure that information about the
backup history for update statistics in the Computing Center Management System (CCMS)
from the old system does not appear in the new system:
   CNHIST, CNREPRT, CNMEDIA, DBSTATHADA, DBSTAIHADA, DBSTATIADA, DBSTATTADA,
   SDBAADAUPD
5. You continue with SAPinst or restart it if you stopped it during the recovery.
6. After installation is completed you maintain the database connection for CCMS. For more
   information, see SAP Note 588515.

5.3 MS SQL Server-Specific Procedure

This section describes how to perform a homogeneous system copy of an MS SQL Server database by
using the backup/restore method, or the detach/attach method in an SAP environment. The SAPinst
installation tool supports both methods.

The backup/restore method and the detach/attach method have the following advantages compared
to the R3load method:
- You can use an existing backup.
- These methods are much faster than the database-independent method [page 17].

   NOTE
   - For more information about the system copy procedure, see also SAP Notes 193816 and 151603.
   - With SQL Server, you can use backup images across the platforms x86, IA64, x64. That is,
     you can make a backup on one type of platform and use it on another type.
   - You can only attach SQL Server 2000 files to SQL Server 2005 but not vice versa.

Process
1. Detach the database files from the source system database or create a backup and copy the files to
   the target system.
2. Attach the database files or restore the backup of the source database on the target database server.
3. Run SAPinst to install the target system by choosing the following on the Welcome screen:
   <Your SAP system> → Software Life-Cycle Options → System Copy → Target System → <system variant>
   → <technical stack>.

   NOTE
   - The target system is installed using the exports from the source system.
Choose the installation options exactly in the order they appear. For more information, see the MS SQL Server installation guide for your SAP system at:

On the SAPinst screen SAP System Database, make sure to select Homogeneous System Copy (MS SQL Server-specific: Detach/Attach or Backup).

End of: Windows | MS SQL Server |

Only valid for: IBM DB2 for Linux and UNIX and Windows |

### 5.4 IBM DB2 for Linux, UNIX, and Windows Specific Procedures

In an SAP system environment, you can create a homogeneous system copy of a DB2 database using the backup method or by relocating your database. The relocation of the database is usually used in conjunction with split mirror. For more information, see the documentation *Database Administration Guide: SAP on IBM DB2 Universal Database for UNIX and Windows*, section *The db2inidb Tool* and the DB2 documentation.

This section provides information on the backup method.

SAPinst is used for the installation on the target system host as described in the installation documentation for your SAP component.

**Advantages of the Backup Method**

- You can use existing offline backups.
- Using the backup method is faster than the database-independent method [page 17].

**Disadvantages of the Backup Method**

- You cannot change the database schema. The database schema will be the same as of the source system.
- You cannot copy an individual MCOD component to another system. You can only copy the complete system.

**Prerequisites**

- The source and target database systems should be binary compatible.

**NOTE**

With DB2 9, you can use backup images cross platform for AIX, Solaris and HP-UX.

- If errors occur when restoring the backup on the target system, the complete restore must be repeated.

**Process**

1. You perform an offline backup or restore an existing backup copy.

**NOTE**

To export the database content for Java, you can also use the database-specific method (backup/restore).
During the dialog phase, SAPinst asks you in the Database Export dialog box to specify the system copy method. If you want to use the backup/restore method, choose Use database specific tools.

2. To create a target system, run SAPinst on the target system host by choosing the following on the Welcome screen:

   ![Your SAP system](Welcome) ➔ Software Life-Cycle Options ➔ System Copy ➔ IBM DB2 for Linux, UNIX, and Windows ➔ Target System ➔ <system variant> ➔ <technical stack>

Perform the installation options in the given sequence and follow the instructions on the SAPinst dialogs. During the installation phase SAPinst prompts you to perform the database restore.

**CAUTION**

Be aware of the following constraints when using the backup method for a homogeneous system copy:

- You cannot change the connect user. During the dialog phase you have to make sure that you enter the name of the connect user exactly as you did on your source system.
- The tablespace names remain the same during the database restore. However, you can change them after the installation.
- If you want to change the container names on the target system, you have to adapt the container names in the redirected restore script and then perform a redirected restore.

For more information, see the documentation *Database Administration Guide: SAP on IBM DB2 Universal Database for UNIX and Windows*, section Usage of Tool *brdb6brt*.

For the restore of your database, you can choose between one of the following options:

- **Simple database restore**
  
  To perform a database restore, use the DB2 restore command. For more information see the IBM DB2 documentation *DB2 Command Reference*.

- **Redirected restore**
  
  You cannot use tool *brdb6brt* to perform a redirected restore.

  For more information about how to perform an offline backup for a Java-only system, see the IBM Documentation IBM DB2 documentation *DB2 Command Reference*.

**NOTE**

You do not have to export the database content for backup/restore with Jload. During the dialog phase, SAPinst asks you if you want to export the database content using database tools or using Jload. If you choose the database tools, Jload is not used.

For more information, see SAP Note 870863.

3. Perform the database restore.

   If you have used an online backup, you have to make sure that you have access to the log files that were created during the online backup. You also have to perform a rollforward operation to bring the database into a consistent state.

   You can now continue with the installation.
4. If required, you can modify the tablespace names after the installation using the following command:

   ```
db2 rename tablespace <old name> to <new name>
   
   EXAMPLE
   db2 rename tablespace <SAPSID_SOURCE>#STABD to <SAPSID_TARGET>#STABD
   ```

More Information


5.5 IBM DB2 for i5/OS Specific Procedure

In an SAP system environment, you can create a homogeneous system copy of a DB2 database using the SAV/RSTLIB method.

A system copy consists of the export of the source system and the import of the target system. The export is normally done by SAPinst. However, for the homogenous system on IBM DB2 for i5/OS using the SAV/RSTLIB method you can only perform a SAVLIB of the library R3<SID>DATA. Finally, you have to copy and transfer the saved database library to the System i host on which you want to create the target system. The import will be performed similar to a normal installation. You have to start the SAPinst by choosing [Software Life-Cycle Options -> System Copy -> IBM DB2 for i5/OS -> Target System]. In one of the SAPinst dialogs, you will be asked if you want to use the R3load method or the database specific method. The database specific method gives you the opportunity to restore the saved library by using RSTLIB. SAPinst creates a restore command from your entered input and restores the database library automatically.

**Advantage of the Offline System Copy Method**

This method is faster than the database-independent method [page 17].

For more information, see SAP Note [585277](http://www.sap.com/).
The following section describes an **offline system copy method** for SAP systems on IBM DB2 for z/OS.

For this example system copy, the high level qualifier of the source system is assumed to be **D8A0** of the target system **D8B0**.

### Advantage of the Offline System Copy Method

This method is faster than the *database-independent method* [page 17].

### Restriction of the Offline System Copy Method

At the moment, you cannot copy an individual MCOD component to another system. You can only copy the complete system.

**NOTE**
The offline system copy must be performed by an experienced database administrator.

You can find an adapted procedure for an **online system copy** in the IBM documentation *High Availability for SAP on zSeries Using Autonomic Computing Technologies*.

### Prerequisites

The following prerequisites must be fulfilled to use this method:

- The permissions of the source and target systems must be completely separate. The source system must not be able to use the resources of the target system, and the target system must not be able to use the resources of the source system.
- RACF authorization for the target DB2 subsystem is complete.
- Source and target systems must work with DB2 managed objects.
- Tablespaces are not partitioned.
- The system copy is made from a non-data sharing system to a non-data sharing system.
- Procedures of the source and the target system are defined in the DB2 PROCLIB.
- Source and target systems have their appropriate entries in the APF list.
- Volumes of the source and target systems are managed by SMS.
- Source and target systems run with the same DB2 service level.

### Variables Used in this Procedure

- Source System = **D8A0**
- Target System = **D8B0**
- Storage Group = **TEMPORA**
- High Level Qualifier = **HLQ**
- Boot Strap Data Set = **BSDS**

### Main Steps in this Procedure

The following sections contain the detailed steps involved in the homogeneous system copy procedure for DB2 for z/OS.
In the following steps, storage groups must be modified to apply the new high level qualifier. This can be achieved by dropping and recreating the storage groups with the new high level qualifier (and volumes).

To prepare the DB2 catalog of the target system, you must run JCL jobs created by SQLs running in the source system.

The offline system copy can be divided into the following steps:
1. **Check the Source System for Consistency**
2. **Stop and Restart the Source System**
3. **Run SQLs in the Source System**
4. **Capture View Definitions** (if you intend to change the schema name.)
5. **Stop the Source System**
6. **Print the Bootstrap Data Sets**
7. **Make Copies of the Source Data Sets**
8. **Create the Target System**
9. **Post-process the Target System**
10. **Changing the VCAT of the Target System**
11. **Changing the Schema of the Target System** (DB2 V9 only)
12. **Adapting WLM Application Environments for DB2 Stored Procedures**

**JCL jobs and SQL Statements**
The JCL jobs and SQL Statements are now located in a compressed file (.zip) that is attached to SAP Note 680746.
The path for each file is given in the section that previously contained the code.

### 5.6.1 Step 1: Check Consistency

The following is a list to help you check the source system for consistency.

- **Check if there are threads.**
- **Check for authorized utilities using the following:**
  ```
  DISPLAY DATABASE(*) UTIL(*)
  ```
  Your output should be:
  No authorized utility found.
  If there are running utilities, you must shut them down properly before continuing.
- **Ensure that all DB2 objects of the source system are started RW mode.**
  This can be checked with
  ```
  DISPLAY DATABASE(*) SPACENAM(*)
  ```
  with keyword
  `RESTRICT.`
For more information, see DB2 UDB for z/OS and OS/390 Command Reference (SC26-9932-05).

- If there are no objects in pending status, the source system must be stopped.

### 5.6.2 Step 2: Stop and Restart the Source System

Now you must stop and restart the source system with the `ACCESS (MAINT)` command option to prohibit any authorization IDs other than install `SYSADM` and install `SYSOPR`.

### 5.6.3 Step 3: Run SQL Statements in the Source System

**Prerequisites**

As described earlier in this section, you must stop and restart the source system with the `ACCESS (MAINT)` command option to prevent changes and to obtain consistent data.

**Information for IBM DB2 V9 for z/OS**

If you are running your system with DB2 V9, note that SQL Statements 2 through 9, as well as Creating a New Storage Group Using the HLQ of the Target System are not relevant tasks for this procedure.

**Activities**

Execute all the following SQL statements in the source system:

#### 5.6.3.1 SQL Statement Number 01

This statement is located at `HSCProcedure\Step3\STMT01.SQL` in the `.zip file [page 48]` attached to SAP Note 680746. For more information, see the section JCL Jobs and SQL Statements.

With this statement, you identify user-defined indexes that you need to change in the DB2 catalog. For more information, see Step 8e: Changing the User-Defined Indexes in the DB2 Catalog [page 62].

**Output**

The output of this statement is similar to the following:

```
+---------+---------+---------+---------+---------+-----+
| NAME    | DBNAME  | INDEXSPACE |
+---------+---------+---------+---------+---------+-----+
| SYSTBLSP~0 | DSNDB06  | SYSTBLSP |
| SYSTABLE~0 | DSNDB06  | SYSTABLE |
```
5.6.3.2  SQL Statement Number 02

This statement is located at
HSCProcedure\Step3\STMT02.SQL
in the .zip file [page 48] attached to SAP Note 680746. For more information, see the section JCL Jobs and SQL Statements.

With this statement, you identify all databases that you want to stop at a later point in time in the target system:

**NOTE**

This task is not relevant for DB2 V9.

**Output**

The output of this statement is similar to the following:

**EXAMPLE**

- STOP DATABASE (A000XAAA)
- STOP DATABASE (A000XAAB)
- STOP DATABASE (A000XAAC)
- STOP DATABASE (A000XAAD)
- STOP DATABASE (A000XAAE)
- STOP DATABASE (A000XAAF)
- STOP DATABASE (A000XAAG)
- STOP DATABASE (A000XAAG)
- STOP DATABASE (A000XAAH)
- STOP DATABASE (A000XAAI)
- STOP DATABASE (A000XAAJ)
- STOP DATABASE (A000XAAK)
- STOP DATABASE (A000XAAAL)
  .
  .
  .
  etc.

5.6.3.3  SQL Statement Number 03

This statement is located at
HSCProcedure\Step3\STMT03.SQL
in the .zip file [page 48] attached to SAP Note 680746. For more information, see the section JCL Jobs and SQL Statements.

With this statement, you identify all tablespaces to be connected at a later point in time to the temporary storage group TEMPORA:

NOTE
This task is not relevant for DB2 V9.

Output
The output of this statement is similar to the following:

EXAMPLE

```
ALTER TABLESPACE A000XAAA.ABAPTREE USING STOGROUP TEMPORA; COMMIT;
ALTER TABLESPACE A000XAAA.ABAPTREE USING STOGROUP TEMPORA; COMMIT;
ALTER TABLESPACE A000XAAA.ADIRACCE USING STOGROUP TEMPORA; COMMIT;
ALTER TABLESPACE A000XAAA.ADOWNERR USING STOGROUP TEMPORA; COMMIT;
ALTER TABLESPACE A000XAAA.ADRCOMCS USING STOGROUP TEMPORA; COMMIT;
ALTER TABLESPACE A000XAAA.ADRDIFIN USING STOGROUP TEMPORA; COMMIT;
ALTER TABLESPACE A000XAAA.ADRGS2 USING STOGROUP TEMPORA; COMMIT;
ALTER TABLESPACE A000XAAA.ADR10 USING STOGROUP TEMPORA; COMMIT;
```

5.6.3.4 SQL Statement Number 04

This statement is located at
HSCProcedure\Step3\STMT04.SQL
in the .zip file [page 48] attached to SAP Note 680746. For more information, see the section JCL Jobs and SQL Statements.

With this statement, you identify all indexes to be connected with storage group TEMPORA.

NOTE
This task is not relevant for DB2 V9.

Output
The output of this statement is similar to the following:

EXAMPLE

```
ALTER INDEX "DSNACC"."UTLEX01" USING STOGROUP TEMPORA; COMMIT;
ALTER INDEX "DSNACC"."UTLSTX01" USING STOGROUP TEMPORA; COMMIT;
```
ALTER INDEX "DSNACC"."UTPEBX01" USING STOGROUP TEMPORA; COMMIT;
ALTER INDEX "DSNACC"."UTPETX01" USING STOGROUP TEMPORA; COMMIT;
ALTER INDEX "DSNACC"."UTPEX01" USING STOGROUP TEMPORA; COMMIT;
ALTER INDEX "DSNACC"."UTPRCX01" USING STOGROUP TEMPORA; COMMIT;
ALTER INDEX "DSNACC"."UTRESTARTX" USING STOGROUP TEMPORA; COMMIT;
ALTER INDEX "DSNACC"."UTRESTART2X" USING STOGROUP TEMPORA; COMMIT;
ALTER INDEX "DSNACC"."UTTMDX01" USING STOGROUP TEMPORA; COMMIT;
ALTER INDEX "DSNACC"."UTTMPX01" USING STOGROUP TEMPORA; COMMIT;

etc.

5.6.3.5 SQL Statement Number 05

This statement is located at
HSCProcedure\Step3\STMT05.SQL
in the .zip file [page 48] attached to SAP Note 680746. For more information, see the section JCL Jobs and SQL Statements.

Storage groups in the target system still contain the high level qualifier of the source system. With this statement, you identify storage groups to be dropped at a later point in time with the following statement:

NOTE

This task is not relevant for DB2 V9.

Output

The output of this statement is similar to the following:

EXAMPLE

DROP STOGROUP SYSDEFLT; COMMIT;
DROP STOGROUP SAPU1I; COMMIT;
DROP STOGROUP SAPU1D; COMMIT;
DROP STOGROUP SAPSOI; COMMIT;
DROP STOGROUP SAPSOD; COMMIT;
DROP STOGROUP SAPESI; COMMIT;
DROP STOGROUP SAPESD; COMMIT;
DROP STOGROUP SAPPRI; COMMIT;
DROP STOGROUP SAPPRI; COMMIT;
DROP STOGROUP SAPLOI; COMMIT;
5.6.3.6 SQL Statement Number 06

This statement is located at
HSCPprocedure\Step3\STMT06.SQL
in the .zip file [page 48] attached to SAP Note 680746. For more information, see the section JCL Jobs and SQL Statements.

NOTE
This task is not relevant for DB2 V9.

With this statement, you identify storage groups to be created at a later point in time with the high level qualifier of the target system. In this case, we assume that FR01 is the high level qualifier of the target system.

Storage Group Naming Conventions
Some storage group names may have to be adapted for all storage groups for which the creator is your SQLID and not SAPR3. The naming convention is as follows:

ABAP Storage Group Naming Convention

<table>
<thead>
<tr>
<th>Schema</th>
<th>Storage Group Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAPR3</td>
<td>SAP&lt;SI&gt;&lt;I</td>
</tr>
<tr>
<td>other</td>
<td>&lt;SID&gt;&lt;SI&gt;&lt;I</td>
</tr>
</tbody>
</table>

NOTE
<SI> signifies the two-character STORAGEID of the table type (TABART).

Java Storage Group Naming Convention

<table>
<thead>
<tr>
<th>Schema</th>
<th>Storage Group Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;schema&gt;</td>
<td>&lt;schema&gt;</td>
</tr>
</tbody>
</table>

CAUTION
For Java, the schema name is also the name of the storage group. You must not change the name of the storage group. Be aware that as of DB2 V9, you can use the CATMAINT utility to globally switch a schema name.

Output
The output of this statement is similar to the following:
CREATE STOGROUP SYSDEFLT VOLUMES('**') VCAT FR01; COMMIT;; COMMIT;
CREATE STOGROUP SAPUI1 VOLUMES('**') VCAT FR01; COMMIT;; COMMIT;
CREATE STOGROUP SAPUI1D VOLUMES('**') VCAT FR01; COMMIT;; COMMIT;
CREATE STOGROUP SAPSOI VOLUMES('**') VCAT FR01; COMMIT;; COMMIT;
CREATE STOGROUP SAPSOD VOLUMES('**') VCAT FR01; COMMIT;; COMMIT;
CREATE STOGROUP SAPESI VOLUMES('**') VCAT FR01; COMMIT;; COMMIT;
CREATE STOGROUP SAPESD VOLUMES('**') VCAT FR01; COMMIT;; COMMIT;
CREATE STOGROUP SAPPRI VOLUMES('**') VCAT FR01; COMMIT;; COMMIT;
CREATE STOGROUP SAPPDR VOLUMES('**') VCAT FR01; COMMIT;; COMMIT;
CREATE STOGROUP SAPLOI VOLUMES('**') VCAT FR01; COMMIT;; COMMIT;
CREATE STOGROUP SAPLOD VOLUMES('**') VCAT FR01; COMMIT;; COMMIT;
.
.
.

etc.

5.6.3.7 SQL Statement Number 07

This statement is located at
HSCProcedure\Step3\STMT07.SQL
in the .zip file [page 48] attached to SAP Note 680746. For more information, see the section JCL Jobs and SQL Statements.

With this statement, you connect tablespaces with their previous storage groups, which now contain the high level qualifier of the target system.

NOTE
This task is not relevant for DB2 V9.

Output
The output of this statement is similar to the following:

EXAMPLE
ALTER TABLESPACE "DSNRLST"."DSNRLS01" USING STOGROUP SYSDEFLT;COMMIT;
ALTER TABLESPACE "BCXXXC5E"."SYNCCLOG" USING STOGROUP SAPD7DB;COMMIT;
ALTER TABLESPACE "BCXXXC5E"."DDDBRTX" USING STOGROUP SAPD7DB;COMMIT;
ALTER TABLESPACE "BCXXXC5E"."DDDBTAB" USING STOGROUP SAPD7DB;COMMIT;
ALTER TABLESPACE "BCXXXC5E"."ABRTX" USING STOGROUP SAPD7DB;COMMIT;
ALTER TABLESPACE "BCXXXC5E"."JMSDMSG" USING STOGROUP SAPD7DB;COMMIT;
ALTER TABLESPACE "CC390"."UTTEMPL" USING STOGROUP SYSDEFLT;COMMIT;
ALTER TABLESPACE "CC390"."UTPROC" USING STOGROUP SYSDEFLT;COMMIT;
ALTER TABLESPACE "CC390"."UTRSTRT" USING STOGROUP SYSDEFLT;COMMIT;
.
.
etc.

### 5.6.3.8 SQL Statement Number 08

This statement is located at
HSCProcedure\Step3\STMT08.SQL
in the .zip file [page 48] attached to SAP Note 680746. For more information, see the section JCL Jobs and SQL Statements.

With this statement, you connect indexes with their previous storage groups, which now contain the high level qualifier of the target system.

**NOTE**
This task is not relevant for DB2 V9.

**Output**
The output of this statement is similar to the following:

**EXAMPLE**

```
ALTER INDEX "SAPDSZ"."SYSTBLSPB0" USING STOGROUP SYSDEFLT;COMMIT;
ALTER INDEX "SAPDSZ"."SYSTABLEB0" USING STOGROUP SYSDEFLT;COMMIT;
ALTER INDEX "SAPDSZ"."SIXPARTB0" USING STOGROUP SYSDEFLT;COMMIT;
ALTER INDEX "STEM"."DSNARL01" USING STOGROUP SYSDEFLT;COMMIT;
.
.
```

**etc.**

### 5.6.3.9 SQL Statement Number 09

This statement is located at
HSCProcedure\Step3\STMT09.SQL
in the .zip file [page 48] attached to SAP Note 680746. For more information, see the section JCL Jobs and SQL Statements.

With this statement, you identify all databases to be started after DB2 catalog manipulations.
NOTE
This task is not relevant for DB2 V9.

Output
The output of this statement is similar to the following:

```
-START DATABASE (A000XAAA)
-START DATABASE (A000XAAB)
-START DATABASE (A000XAAC)
-START DATABASE (A000XAAD)
-START DATABASE (A000XAAE)
-START DATABASE (A000XAAF)
-START DATABASE (A000XAAAG)
-START DATABASE (A000XAAAH)
-START DATABASE (A000XAAAI)
-START DATABASE (A000XAAAJ)
-START DATABASE (A000XAAK)
-START DATABASE (A000XAAL)
.
.
etc.
```

5.6.4 Step 4: Capturing View Definitions with DB2 V9 (if the Schema Name is to be Changed)

DB2 V9 adds the capability to change the VCAT name to the CATMAINT utility. This new capability facilitates **homogenous system copy**. Moreover, the CATMAINT utility can change the schema and creator of objects.

If you intend to also change the schema name as part of the homogeneous system copy, for example for SAP Java systems, you need to capture the view definitions in this step. This is necessary since renaming the schema using CATMAINT requires that no views exist on the tables for which a VCAT name is changed. Therefore, the view definitions are exported in this step using R31dct1.

As part of the post-processing steps that are performed in the target system, the saved view definitions are later used to recreate the views in the target system. The views may also be saved and later recreated in the target system using alternative tools.

**Procedure**

To export the view definitions using R31dct1:
1. Run R3lctl without parameters to create the DDLDB2.TPL file, the SAPVIEW.STR file and others.
2. Store these files.

### 5.6.5 Step 5: Stop the Source System

Stop the source system with the following command option:

```plaintext
MODE (QUIESCE)
```

### 5.6.6 Step 6: Making Copies of Source Data Sets

With this step, you make copies of the source data sets, which includes:

- DB2 bootstrap data sets
- DB2 logcopy data sets
- All DB2 VSAM data sets belonging to the source system

With these JCL jobs, you can make copies of the source data sets:

- HSCProcedure\Step6\DUMPA0.JCL
- HSCProcedure\Step6\DUMPA1.JCL
- HSCProcedure\Step6\DUMPA2.JCL
- HSCProcedure\Step6\DUMPLIB.JCL
- HSCProcedure\Step6\DUMPLOG.JCL
- HSCProcedure\Step6\DUMPREST.JCL

All scripts are located in the .zip file [page 48] attached to SAP Note 680746. For more information, see the section JCL Jobs and SQL Statements.

---

**NOTE**

The source system can be restarted now. It is no longer needed for the following system copy process.

### 5.6.7 Step 7: Creating the Target System

With the following JCL jobs, you create the target system.

In the first step, the dumps of the source system have to be restored. All data sets of the source system have to be restored with the high level qualifier of the target system.

All statements are located in the .zip file [page 48] attached to SAP Note 680746. For more information, see the section JCL Jobs and SQL Statements.

- HSCProcedure\Step7\RSTOREA0.JCL
- HSCProcedure\Step7\RSTOREA1.JCL
- HSCProcedure\Step7\RSTOREA2.JCL
5.6.8 **Step 9a: Changing the Bootstrap Data Sets (BSDS)**

Before starting the target system, the BSDS must be changed.

The JCL jobs listed here are located in the `.zip file` [page 48] attached to **SAP Note 680746**. For more information, see the section **JCL Jobs and SQL Statements**.

1. Change the HLQ entry in the BSDS of the target system, using the HLQ D8B0.
   
   The corresponding JCL job is located at
   
   ```
   HSCProcedure\Step9a\CHGBSDS1.JCL
   ```
   
   in the `.zip file`.

2. Change the log entries in the BSDS. The START and END RBA information as of utility DSNJU004 have to be used for the target system as follows:

   The corresponding JCL job is located at
   
   ```
   HSCProcedure\Step9a\CHGBSDS2.JCL
   ```
   
   in the `.zip file`.

After changing the BSDS with these scripts, you can start the target system.

5.6.9 **Step 9b: Start the Target System**

When you start the DB2 target system for the very first time, the system is still working with the work file database of the source system. However, access fails with insufficient access authority, as seen in the log.

Partial example of a LOG when you start the target system for the first time:

```
SYNTAX

... ...

DSNR005I  -D8B0 RESTART...COUNTS AFTER FORWARD 604
RECOVERY
IN COMMIT=0, INDOUBT=0
DSNR006I  -D8B0 RESTART...COUNTS AFTER BACKWARD 605
RECOVERY
INFLIGHT=0, IN ABORT=0, POSTPONED ABORT=0
DSNP012I  -D8B0 DSNPCNP0 - ERROR IN VSAM CATALOG 606
LOCATE FUNCTION FOR D8A0.DSNDBC.DSNDB07.DSN4K01.I0001.A001
CTLGRC=AAAAAA08
CTLGRSN=AAAAAA08
CONNECTION-ID=D8E0, CORRELATION-ID=003.RCRSC 02,
LUW-ID=*IKJ56228I DATA SET D8A0.DSNDBC.DSNDB07.DSN4K01.I0001.A001 NOT IN CATALOG
```
We strongly recommend that you maintain different RACF settings for different DB2 subsystems. If not, the target system has access to the data sets of the source system and the data of the source system could be changed by mistake.

The work file database data must be changed later in the clone process.

### 5.6.10 Step 9c: Creating a New STOGROUP Using the HLQ of the Target System

With this JCL job, you create a new STOGROUP using the HLQ of the target system (D8B0). This JCL job is located at

HSCPProcedure\Step9c\CRTMPSTO.JCL

.zip file [page 48] attached to SAP Note 680746. For more information, see the section JCL Jobs and SQL Statements.

**NOTE**
This task is not relevant for DB2 V9.

### 5.6.11 Step 9d: Stopping Index Spaces

With this JCL job, you stop the appropriate index spaces. You find a list of index spaces in the output of SQL statement number 1 [page 51].

The JCL job is located at

HSCPProcedure\Step9d\STOPIDX.S.JCL

in the .zip file [page 48] attached to SAP Note 680746. For more information, see the section JCL Jobs and SQL Statements.
5.6.12 Step 9e: Changing the User-Defined Indexes in the DB2 Catalog

After starting the target system, the user-defined indexes (the output of SQL statement number 1 [page 51]) in the DB2 catalog must be changed, working with the new HLQ of the target system D8B0. The following example script can be used to carry out this procedure.

Change the user-defined DB2 catalog indexes using the new storage group TEMPORA.

This JCL job is located at HSCProcedure\Step9e\ALTERIDX.JCL in the .zip file [page 48] attached to SAP Note 680746. For more information, see the section JCL Jobs and SQL Statements.

5.6.13 Step 9f: Restart the Index Spaces

At this point, you must restart the index spaces.

5.6.14 Step 9g: Creating the Temporary Files for the DB2 Target System

To create the temporary files for the DB2 target system:

1. Run part of DSNTIJTM to create temporary files for DB2. DSNTIJTM was generated by DSNTINST (optional) or consists of a manually changed copy from another existing DB2 subsystem.

The JCL job is located in the .zip file at HSCProcedure\Step9g\CRTTMPFL.JCL.

The .zip file [page 48] attached to SAP Note 680746. For more information, see the section JCL Jobs and SQL Statements.

2. Stop and restart the DB2 subsystem. The error as described in Step 6: Make Copies of the Sources Data Sets [page 59] should not occur since DB2 is working with the new temporary files.

5.6.15 Step 9h: Implementing HLQ of the Target System in the Work File Database

In the next step, the work file database is changed to use the new HLQ D8B0.

Procedure

To change the work file database:

1. Drop work file database DSNDB07 in the target system, delete the clusters for 4K and 32K and create them again.
2. Stop and restart the target system.
Error message IKJ56228I should not appear because DB2 is now working with its own work file database.

5.6.16 Step 9i: Adjusting the DDF Location Name and Port Number

To allow communication with the SAP application servers of the DB2 target system, you must adjust the DDF location name and port number.

**Procedure**

To adjust the DDF location name and port number, run the DB2 utility DSNJU003 with the option DDF to specify the location name and port number.

5.6.17 Step 10 (DB2 V8 and Lower): Changing the VCAT of the Target System

The target system with the new HLQ D8B0 still works with storage groups using VCAT D8A0. In the following steps, the DB2 catalog is manipulated by stopping the databases, altering tablespaces and indexes, dropping and creating storage groups with the new VCAT D8B0, altering tablespaces and indexes using the new storage groups, and starting all databases. The objects to be manipulated are identified by the results of previously described SQL statements. All SQL statements listed here are located in the .zip file [page 48](#) attached to SAP Note 680746. For more information, see the section JCL Jobs and SQL Statements.

**Procedure**

1. **Stop all databases**
   
   The corresponding JCL job is located at HSCProcedure/Step10/STOPDBS.JCL.

2. **Alter tablespaces using storage group TEMPORA**
   
   The corresponding JCL job is located at HSCProcedure/Step10/ALTERTBS.JCL.

3. **Alter indexes using storage group TEMPORA**
   
   The corresponding JCL job is located at HSCProcedure/Step10/ALTERIDX.JCL.

4. **Drop the storage groups**
   
   The corresponding JCL job is located at HSCProcedure/Step10/DROPSTG.JCL.

5. **Create the storage groups**

   The corresponding JCL job is located at
6. Alter tablespaces using their previous storage group
   The corresponding JCL job is located at
   HSCProcedure\Step10\ALERTB2.JCL.

7. Alter indexes using their previous storage group
   The corresponding JCL job is located at
   HSCProcedure\Step10\ALTERID2.JCL.

8. Start all databases
   This JCL job is located at
   HSCProcedure\Step10\STARTDBS.JCL.

   If necessary, change the user authorizations of the target system. The DB2 catalog still contains the
   authorizations of the source system.

5.6.18 Step 10 (DB2 V9): Changing the VCAT of the Target System

To change the VCAT that is used for the storage groups of your SAP tables and indexes, proceed as
follows.

Procedure
1. Ensure that the DB2 EDM pool and DB2 EDM DBD cache have at least the following sizes:
   - EDMPOOL ≥ 200000 KB
   - EDMDBDC ≥ 300000 KB
2. Call the CATMAINT utility with the UPDATE VCAT option to switch the VCAT name
3. Reinstate the original sizes of EDMPOOL and EDMDBDC.
4. Start the DB2 subsystem in regular mode

   If necessary, change the user authorizations of the target system. The DB2 catalog still contains the
   authorizations of the source system.

5.6.19 Step 11 (DB2 V9): Changing the Schema of the Target System

To change the schema or creator name of your SAP tables and indexes, proceed as follows. This approach
requires that you have previously invoked R3ldctl on your source system to capture the view
definitions of the SAP system.

Procedure
1. If user-defined materialized query tables or triggers exist, save their definitions in a separate place
2. Delete all views, materialized query tables and triggers that exist on the SAP tables
3. Ensure that the DB2 EMD pool and DB2 EDM DBD cache have at least the following sizes:
   - EDMPOOL ≥ 200000 KB
   - EDMDDBC ≥ 300000 KB
4. Call the CATMAINT utility with the SCHEMA SWITCH option to switch the schema name
5. Reinstate the original sizes of EDMPOOL and EDMDDBC.
6. Start the DB2 subsystem in regular mode
7. Recreate the views by implementing the following steps:
   1. Generate the R3load taskfiles by submitting the following command:
      ```
      R3load -ctf I SAPVIEW.STR DDLDB2.TPL SAPVIEW.TSK DB2 -l SAPVIEW.log
      ```
   2. Create a SAPVIEW.cmd file to prepare the recreation of the views. This file can contain the following lines for example:
      ```
      EXAMPLE
      tsk: "SAPVIEW.TSK"
      icf: "SAPVIEW.STR"
      dcf: "DDLDB2.TPL"
      dat: null
      dir: null
      ext: null
      ```
   3. Call R3load with the option
      ```
      -i SAPVIEW.cmd -dbcodepage <codepage> -l SAPVIEW.log
      ```
      to recreate the views.
8. If user-defined materialized query tables or triggers exist, recreate them.

5.6.20 Step 12: Adapting WLM Application Environments for DB2 Stored Procedures

The WLM environments of the WLM-established stored procedures need to be changed if the target system is running with other WLM environments.

**Procedure**

To change the WLM environments of the WLM-established stored procedures, carry out the following steps:

1. Create WLM application environments for the DB2 stored procedures as described in the *SAP DBA Guide: DB2 for z/OS*.
2. Use the ALTER PROCEDURE statement as described in the IBM documentation *DB2 for z/OS SQL Reference*.
6 Copying Single Instances Only

If you want to copy single instances of your SAP system only, you can use one of the following procedures, depending on your use case:

- Copying the Database Only – Move [page 67]
- Copying the Database Only – Refresh [page 68]

**CAUTION**

You cannot copy single usage types!

6.1 Copying the Database Only – Move

With this procedure you can move a database instance to a different host within your system. The move can be done using either database-specific methods or the SAP standard method based on R3load/Jload.

**CAUTION**

- The DBSID must not be changed.
- When copying the database only, you cannot change to another database but need to perform a database-homogeneous copy.
- The old database instance cannot be uninstalled using the SAPinst based uninstall procedure. This will always delete the current database of the system.

**Procedure**

1. On the source host, run SAPinst on UNIX or Windows [page 19] or run SAPinst on IBM System i [page 22] to perform the export.
2. If you perform the export using R3load/Jload, on the Welcome screen, choose <your product> "Software Life-Cycle Tasks" → "System Copy" → "Source System" → <your system variant> → <technical stack> → "Database instance export" to export the database.
   
   If you perform the export using database-specific tools, you must start them manually.
3. On the target host, stop all SAP instances except the primary application server.
4. On the target system, run SAPinst and choose <your product> "Software Life-Cycle Tasks" → "System Copy" → "Target System" → <your system variant> → <technical stack> → "Database Refresh or Move" to install the database.

**NOTE**

As the target database instance is to replace the source database, do not change the DBSID.
5. Follow the on-screen instructions.

6. When you get to the Summary screen, shut down your primary application server and choose Next to start the installation.

7. When SAPinst has completed the installation of the database, restart your system including all instance services.

8. Shut down the old database instance.

9. Only valid for: UNIX | MaxDB |
   Set up the xuser entries from the home directory of the user <sapsid>adm on each additional application server as follows:
   ```
xuser -U <key> -u <dbuser>,<password> -d <dbsid> -n <dbhost> -S SAPR3 -t 0 -I 0 set
   
   The required keys and dbusers are as follows:
   - Key DEFAULT with dbuser SAP<SID>
   - Key c_j2ee with dbuser control
   - Key w with dbuser superdba
   ```

10. Only valid for: Windows | MaxDB |
    Set up the xuser entries from the home directory of the users <sapsid>adm and SAPService<SID> on each additional application server as follows:
    ```
xuser -c <os_user> -U <key> -u <dbuser>,<password> -d <dbsid> -n <dbhost> -S SAPR3 -t 0 -I 0 set
    
    The required keys and dbusers are as follows:
    - Key DEFAULT with dbuser SAP<SID>
    - Key c_j2ee with dbuser control
    - Key w with dbuser superdba
    ```

### 6.2 Copying the Database Only – Refresh

With this procedure you can refresh the content of an existing database without having to copy the primary application server instance and to reinstall additional applications servers. The refresh can be done using either database-specific methods or the SAP standard method based on R3load/Jload.

**CAUTION**
- When copying the database only, you cannot change to another database but need to perform a database-homogeneous copy.

**Prerequisites**
The source system and the target system already exist.
Procedure

1. On the source system, note down the IDs for each of the Java instances in the profile of the application server.
   The ID is stored in the instance as parameter j2ee/instance_id.
2. On the source system, run SAPinst on UNIX or Windows [page 19] or run SAPinst on IBM System i [page 22] to perform the export.
3. If you perform the export using R3load/Jload, on the Welcome screen, choose ▶ <your product> → Software Life-Cycle Tasks → System Copy → Source System → <your system variant> → <technical stack> → Database instance export ▶ to export the database.
   If you perform the export using database-specific tools, you must start them manually.
4. On the target system, stop all SAP instances except the primary application server.
5. Run SAPinst and choose ▶ <your product> → Software Life-Cycle Tasks → System Copy → Target System → <your system variant> → <technical stack> → Database Refresh or Move ▶ to install the database.
6. When you get to the Summary screen, shut down your primary application server and choose Next to start the installation.

   **NOTE**
   On System i you have to delete your database libraries manually before you start the installation. Make sure that these libraries are currently not added to any library list. To delete a library use the command DTLIB.
   For ABAP delete the libraries: R3<SID>DATA and R3<SID>JRN.
   For Java delete the libraries: SAP<SID>DB and SAP<SID>JRN.
   Use the command DSPJOBLOG to analyze any upcoming error. Finally choose Next to start the installation.
7. When SAPinst has completed the installation of the database, adapt the profiles in the application server on the target system by reassigning the profile IDs of the Java instances, making sure that they are the same as on the source system.

   **NOTE**
   If there are more application servers on the target system than on the source system, you have to reinstall the ones that additionally exist on the target system.

   **EXAMPLE**
   Source System:
   ABC_DVEBMGS88_<host1>:j2ee/instance_id = ID8873787
   ABC_D00_<host1>:j2ee/instance_id = ID32225
   ABC_D20_<host2>:j2ee/instance_id = ID2078823

   **Target System (before reassignment):**
   XYZ_DVEBMGS77_<host1>:j2ee/instance_id = ID7732291
   XYZ_D00_<host2>:j2ee/instance_id = ID74637
   XYZ_D01_<host1>:j2ee/instance_id = ID129016
Target System (after reassignment):

XYZ_DVEBMGS77_<host1>:j2ee/instance_id = ID8873787
XYZ_D00_<host2>:j2ee/instance_id = ID32225
XYZ_D01_<host1>:j2ee/instance_id = ID2078823

CAUTION

One application server (AS) is assigned to exactly one Java instance, and vice versa. That means that, in the target system, you need to assign every Java instance in the database to exactly one application server. You **cannot** assign the same Java instance to more than one application server.
7 Follow-Up Activities

To finish the system copy of your SAP system:

- Perform follow-up activities in the target system [page 71]

NOTE
The Java EE engine is not started automatically. After the target system has been installed and the follow-up activities have been performed, you have to start the Java EE engine manually.

7.1 Performing Follow-Up Activities in the Target System

To complete the system copy process, you need to perform several follow-up activities on the target system.

7.1.1 Installing the License Key

Once the installation of the target system is completed and the SAP system copy has been imported, you have to install a new license key. For more information about ordering and installing the SAP license, see the SAP Library [page 8] at Administrator’s Guide → Technical Operations for SAP NetWeaver → General Administration Tasks → License Administration.

7.1.2 Performing Follow-Up Activities for Java

Depending on the software units contained in your target system, you have to perform general and software unit-specific configuration steps:

- General follow-up activities [page 71]
- Software Unit-specific follow-up activities [page 72]

7.1.2.1 General Follow-Up Activities

You have to perform the following activities for all software units of the copied SAP system.
7.1.2.1 Generating Public-Key Certificates

Reconfiguring the Public-Key Certificates

After the system copy, the public-key certificates are not correct on the target system. You need to reconfigure them as described in the SAP Library [page 8] at Function-Oriented View → Security → User Authentication and Single Sign-On → Integration in Single Sign-On (SSO) Environments → Single Sign-On for Web-Based Access → Using Logon Tickets → Using Logon Tickets with AS Java → Configuring the AS Java to Issue Logon Tickets → Replacing the Key Pair to Use for Logon Tickets.

Importing the Public-Key Certificates

You also need to import this public-key certificate on any systems that are to accept logon tickets from the AS Java system. For more information, see the SAP Library [page 8] at Function-Oriented View → Security → User Authentication and Single Sign-On → Integration in Single Sign-On (SSO) Environments → Single Sign-On for Web-Based Access → Using Logon Tickets → Using Logon Tickets with AS Java → Accepting Logon Tickets Issued by the AS Java.

7.1.2.2 Software Unit-Specific Follow-Up Activities

You have to perform the following activities for specific software units of the copied SAP system.

7.1.2.2.1 AS Java: Adobe Document Services

Procedure

Copying Files to the Target System

After performing a system copy, some additional files need to be copied manually from the original ADS system to the target system.

1. Copy the following files and subdirectories:
   - DIR_GLOBAL\AdobeDocumentServices\TrustManagerService\trust\*. *
   - DIR_GLOBAL\AdobeDocumentServices\JobProfiles\Custom\*. *
   - DIR_GLOBAL\AdobeDocumentServices\FontManagerService\fonts\customer\*. *
   - DIR_GLOBAL\AdobeDocumentServices\lib\custom_*.*

2. If you have adjusted the threshold for error file logging in the ADS, or if you are not sure whether you have adjusted it, copy the following file to your target system:
   - DIR_GLOBAL\AdobeDocumentServices\lib\renderErrorLog\renderErrorLogConfig.xml

3. If you have made modifications to any XDC files, copy all XDC files to your target system:
   - DIR_GLOBAL\AdobeDocumentServices\lib\*. xdc

   **NOTE**

   When copying the files to the new system, do not replace any existing files. Otherwise the changes made the XDC files provided by Adobe will be overwritten on system restart.
4. Restart your target system.

**Manual Configuration**

1. Adjust the RFC connection ADS.
   Make sure you change the server name, the port, and the authentication information to match the target system.
2. Create the HTTP destination `FP_ICF_DATA_<SAPSID of target system>`.

### 7.1.3 Performing Jobhead Correction after Homogeneous System Copy

**NOTE**

This section is only relevant for customers using CCMS to monitor their SAP system(s).

After copying your system, the CCMS jobhead still points to the former database SSID. In order to complete the homogeneous system copy, the **SSID** needs to be set to the target system.

**CAUTION**

Only experienced users should use this utility.

**Procedure**

To set the **SSID** to the target system:

1. Call transaction `DBACOCKPIT`.
2. Choose `Configuration ➔ Homogeneous System Copy: Jobhead Correction`.
3. Modify the necessary data.
This page is left blank for documents that are printed on both sides.
8 Additional Information

8.1 Additional Information About SAPinst

The following sections provide additional information about SAPinst:

- Using SAPinst GUI [page 75]
- Useful Information About SAPinst [page 76]
- Interrupted Installation with SAPinst [page 79]
- Performing a Remote Installation with SAPinst (Optional) [page 81]
- Starting SAPinst GUI Separately (Optional) [page 85].
- Only valid for: IBM DB2 for Linux and UNIX and Windows; IBM DB2 for z/OS; MaxDB; MS SQL Server; Oracle |

Entries in the Services File Created by SAPinst [page 89]

End of: IBM DB2 for Linux and UNIX and Windows; IBM DB2 for z/OS; MaxDB; MS SQL Server; Oracle |

- Troubleshooting with SAPinst [page 90]

8.1.1 Using SAPinst GUI

The following table shows the most important functions that are available in SAPinst GUI:

<table>
<thead>
<tr>
<th>Input Type</th>
<th>Label</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Function key</td>
<td>F1</td>
<td>Displays detailed information about each input parameter</td>
</tr>
<tr>
<td>Menu option</td>
<td>File → Exit</td>
<td>Stops the SAPinst GUI, but SAPinst and the GUI server continue running</td>
</tr>
<tr>
<td>Menu option</td>
<td>SAPinst → Log Browser</td>
<td>Displays the Log Viewer dialog</td>
</tr>
</tbody>
</table>

NOTE

If you need to log off during the installation from the host where you control the installation with SAPinst GUI, the installation continues while you are logged off. You can later reconnect to the same SAPinst installation from the same or another host.
For more information, see Starting SAPinst GUI Separately [page 85].

Displays the Log Viewer dialog
This dialog enables you to access the following log files directly:
- Installation log (sapinst_dev.log)
- Log files from the SAPinst GUI server
### 8.1.2 Useful Information About SAPinst

When you start SAPinst, SAPinst GUI and the GUI server are also started. SAPinst GUI connects using a secure SSL connection to the GUI server and the GUI server connects to SAPinst.

SAPinst normally creates the directory `sapinst_instdir` directly below the temporary directory. SAPinst finds the temporary directory by checking the value of the environment variables `TEMP`, `TMP`, or `TMPDIR`. If no value is set for these variables, SAPinst uses `/tmp` as default directory.

#### Features
- Make sure that the `DISPLAY` environment variable is set to `<host_name>:0.0`, where `<host_name>` is the host where the SAPinst GUI is displayed.
- Make sure that your `SAPINST_JRE_HOME` environment variable is set to a valid Java Runtime Environment (JRE).
- If the operating system is AIX 64-bit, make sure that the `PATH` variable points to a JDK/JRE for AIX 64-bit.
- Before starting the export, make sure that you have at least the same amount of disk space available in `/sapmnt/<SAPSID>/<InstanceName>/SMD/program` as is used in `/sapmnt/<SAPSID>/<InstanceName>/SMD/root/origin`. During the export, some archives are written to the program sub-directories and SAPinst aborts if there is not enough space.
- Before you start the export of the existing SAP System, you have to download the current version of R3szchk at [http://service.sap.com/patches](http://service.sap.com/patches) and copy it to directory `/usr/sap/<>/SYS/exe/run/`. 

### Table: SAPinst Options

<table>
<thead>
<tr>
<th>Label</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Menu option**

- **Cancel**
  - Cancels the installation with the following options:
    - **Stop**
      - Stops the installation (SAPinst GUI, SAPinst and the GUI server) without further changing the installation files.
      - You can restart and continue the installation later from this point.
    - **Continue**
      - Continues the installation

- **Continue**

- **Stop**
  - Stops the installation without further changing the installation files
  - You can continue the installation later from this point.

- **Retry**
  - Performs the installation step again (if an error has occurred)
NOTE
For a list of all available SAPinst properties, enter the following command: sapinst -p.

When you start SAPinst, SAPinst GUI and the GUI server also start. SAPinst GUI connects using a secure SSL connection to the GUI server and the GUI server connects to SAPinst.

SAPinst normally creates the installation directory sapinst_instdir, where it keeps its log files, and which is located directly in the Program Files directory. If SAPinst is not able to create sapinst_instdir directly below the Program Files directory, SAPinst tries to create sapinst_instdir in the directory defined by the environment variable TEMP.

SAPinst creates a subdirectory for each installation option, called <sapinst_instdir> \<installation_option> which is located in %ProgramFiles%.

The SAPinst Self-Extractor extracts the executables to a temporary directory (TEMP, TMP, TMPDIR, or SystemRoot). These executables are deleted after SAPinst has stopped running. Directories called sapinst_exe.xxxxx.xxxx sometimes remain in the temporary directory. You can safely delete them.

The temporary directory also contains the SAPinst Self-Extractor log file dev_selfex.out, which might be useful if an error occurs.

CAUTION
If SAPinst cannot find a temporary directory, the installation terminates with the error FCO-00058.

If you want to terminate SAPinst and the SAPinst Self-Extractor, do one of the following:

- Right-click the icon for the SAPinst output window located in the Windows tray and choose Exit.
- Click the icon for the SAPinst output window located in the Windows tray and choose File \ Exit.

During the installation, the default ports 21200, 21212, and 4239 are used for communication between SAPinst, GUI server, SAPinst GUI, and HTTP server. SAPinst uses port 21200 to communicate with the GUI server. The GUI server uses port 21212 to communicate with SAPinst GUI. 4239 is the port of the HTTP server, which is part of the GUI server. You get an error message if one of these ports is already in use by another service.

In this case, open a command prompt and change to the required directory as follows:

\<DVD drive>:\DATA_UNITS\IM_WINDOWS_<platform>.

Enter the following command in a single line:

```
.sapinst.exe SAPINST_DIALOG_PORT=<free_port_number_sapinst_to_gui_server>
GUISERVER_DIALOG_PORT=<free_port_number_gui_server_to_sapinst_gui>
GUISERVER_HTTP_PORT=<free_port_number_http_server>
```

For a list of all available SAPinst properties, enter the following command: sapinst -p.
NOTE
For more information about input parameters in SAPinst, position the cursor on the parameter field and choose \[F1\].

Troubleshooting

CAUTION
If an export process aborts due to a hardware failure (for example, file system full), you have to repeat the export of the complete package. Remove the dump files `<package>.<nnn>`, the TOC file `<package>.TOC`, the log file `<package>.log` and make sure that all tables in the TSK file `<package>.*TSK*` have the status flag 'xeq' or 'err' set.

- If there is not enough disk space in the export directory, the R3load database export fails. You can then find error messages in the log files `SAP*.log`.
  You can subsequently move the dump files that have been created from the file system in which the export directory is located to a different file system during the export. Currently it is not possible to automatically distribute the export over different file systems.
- If an error occurs during the dialog phase, SAPinst:
  - Stops the export.
  - Displays a dialog that informs you about the error.
  You can now directly view the log file by choosing View Logs.
  Finally you must abort the export with OK and try to solve the problem.
- If an error occurs during the processing phase, SAPinst:
  - Stops the export.
  - Displays a dialog that informs you about the error.
  You can now:
    - Directly view the log file by choosing View Logs.
    - Try to solve the problem.
    - Continue the export by choosing Retry.
    - Abort the export by choosing OK.

System Copy - export on UNIX (especially for upgraded systems)
**Symptom:**
Processes started as `<sapsid>adm` or `<ora<sid>` OS users cannot create or open files in the installation directory.

**Reason:**
Only members of sapinst UNIX group can access the installation directory.
This group is created by SAPinst as of SAP NetWeaver 7.1.

**Solution:**
Associate `<sapsid>adm` and `<ora<sid>` OS users with sapinst group manually if this association is missing.
Verify `/etc/group` file and check if `sapinst` group exists and OS users are members of this group. If `sapinst` group does not exist yet, start SAPinst. SAPinst will create this group during startup before product catalog list will be displayed.

Edit `/etc/group` file and associate OS users with `sapinst` group. Continue with the export.

See also `Interrupted Installation with SAPinst` [page 79].

### 8.1.3 Interrupted Installation with SAPinst

The SAP system installation might be interrupted for one of the following reasons:

- An error occurred during the dialog or processing phase:
  
  SAPinst does not abort the installation in error situations. If an error occurs, the installation pauses and a dialog box appears. The dialog box contains a short description about the choices listed in the table below as well as a path to a log file that contains detailed information about the error.

- You interrupted the installation by choosing `Exit` in the SAPinst menu.

The following table describes the options in the dialog box:

<table>
<thead>
<tr>
<th>Option</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Retry</strong></td>
<td>SAPinst retries the installation from the point of failure without repeating any of the previous steps. This is possible because SAPinst records the installation progress in the <code>keydb.xml</code> file. We recommend that you view the entries in the log files, try to solve the problem and then choose <code>Retry</code>. If the same or a different error occurs again, SAPinst displays the same dialog box again.</td>
</tr>
<tr>
<td><strong>Stop</strong></td>
<td>SAPinst stops the installation, closing the dialog box, the SAPinst GUI, and the GUI server. SAPinst records the installation progress in the <code>keydb.xml</code> file. Therefore, you can continue the installation from the point of failure without repeating any of the previous steps. See the procedure below.</td>
</tr>
<tr>
<td><strong>Continue</strong></td>
<td>SAPinst continues the installation from the current point.</td>
</tr>
</tbody>
</table>

**Procedure**

This procedure describes the steps to restart an installation, which you stopped by choosing `Stop`, or to continue an interrupted installation after an error situation.

1. **Only valid for: Windows**
   
   Log on to your remote host as a user who is a member of the local administrators group.

   **End of: Windows**

2. **Only valid for: UNIX | IBM DB2 for Linux and UNIX and Windows;IBM DB2 for z/OS;MaxDB;Oracle**
   
   Log on to your local UNIX host as user `root`.
8.1 Additional Information About SAPinst

**CAUTION**

Make sure that the root user has not set any environment variables for a different SAP system or database.

3. Only valid for: IBM i5/OS | IBM i5/OS | IBM DB2 for i5/OS |

Log on to your local System i host as a user with similar authorization rights as QSECOFR.

4. Only valid for: UNIX, Windows |

Mount your Installation Master DVD.

**NOTE**

Mount the DVD locally. We do not recommend using Network File System (NFS).

5. Only valid for: UNIX |

Make available your Installation Master DVD.

**NOTE**

Make sure that the DVD is available locally. We do not recommend using Network File System (NFS).

6. Only valid for: Windows | IBM DB2 for Linux and UNIX and Windows; IBM DB2 for z/OS, MaxDB; MS SQL Server; Oracle |

Restart SAPinst by double-clicking sapinst.exe. You can also start SAPinst by entering the following commands at the Windows command prompt:

```
cd <DVD drive>::\IM_WINDOWS<platform>
```

7. Only valid for: Windows | IBM DB2 for Linux and UNIX and Windows; IBM DB2 for z/OS, MaxDB; MS SQL Server; Oracle |

Restart SAPinst by double-clicking sapinst.exe You can also start SAPinst by entering the following commands at the Windows command prompt:

```
<command>:\DATA_UNITS\IM_WINDOWS_X86_64_DB4
```

8. Only valid for: UNIX | IBM DB2 for Linux and UNIX and Windows; IBM DB2 for z/OS, MaxDB; Oracle |

Enter the following commands:

```
cd <mountpoint_of_Installation Master_DVD>/DATA_UNITS/IM_<OS>_<DB>
./sapinst
```

**EXAMPLE**

For example, if the mountpoint of the Installation Master DVD is sapcd2, the operating system is LINUX_X86_64 and the database is Oracle, the commands are as follows:

```
cd /sapcd2.DATA UNITS/IM_LINUX_X86_64_ORA
```
### 8.1.4 Performing a Remote Installation with SAPinst (Optional)

You use this procedure to install your SAP system on a remote host. In this case, SAPinst and the GUI server run on the remote host, and SAPinst GUI runs on the local host. The local host is the host from which you control the installation with SAPinst GUI.

**Prerequisites**

- Both computers are in the same network and can “ping” each other.

  To test this:
  - Log on to your remote host and enter the command `ping <local host>`. 
Log on to the local host and enter the command `ping <remote host>`.

Procedure

1. Log on to your remote host as a user who is a member of the local administrators group.
2. Insert the Installation Master DVD in the DVD drive on your remote host.
3. Enter the following commands:

   ```
   cd <DVD drive>:\DATA_UNITS\IM_WINDOWS_<platform>
   ```

   ```
   cd <mapped drives>:\DATA_UNITS\IM_WINDOWS_X86_64_DB4
   ```

   `sapinst.exe -nogui`

   For more information, on how to perform the export, see Running SAPinst to Perform the Export [page 19].

   SAPinst now starts and waits for the connection to the SAPinst GUI. You see the following at the command prompt:

   `guiengine: no GUI connected; waiting for a connection on host <host_name>, port <port_number> to continue with the installation`

4. Start SAPinst GUI on your local host, as described in Starting SAPinst GUI Separately [page 85].

   ```
   sapinst.exe -nogui
   ```

   For example, if the mountpoint of the Installation Master DVD is `sapcd2`, the operating system is `LINUX_X86_64` and the database is Oracle, the commands are as follows:

   ```
   ./sapinst -nogui
   ```
8.1 Additional Information About SAPinst

```bash
cd /sapcd2/DATA_UNITS/IM_LINUX_X86_64_ORA
./sapinst -nogui
```

For more information, see *Running SAPinst to Perform the Export* [page 19].

SAPinst now starts and waits for the connection to the SAPinst GUI. You see the following at the command prompt:

```text
guiengine: no GUI connected; waiting for a connection on host <host_name>, port <port_number> to continue with the installation.
```

4. Start SAPinst GUI on your local host, as described in *Starting SAPinst GUI Separately* [page 85].

5. Log on to your remote host as user root.

   **CAUTION**

   Make sure that the root user has not set any environment variables for a different SAP system or database.

6. Mount the Installation Master DVD.

7. Enter the following commands:

   ```bash
cd <Installation_Master_DVD>/IM_<OS>
```

   For more information, see *Running SAPinst to Perform the Export* [page 19].

   SAPinst now starts and waits for the connection to the SAPinst GUI. You see the following at the command prompt:

   ```text
guiengine: no GUI connected; waiting for a connection on host <host_name>, port <port_number> to continue with the installation.
```

8. Start SAPinst GUI on your local host, as described in *Starting SAPinst GUI Separately* [page 85].

   **CAUTION**

   Make sure that the installation user has not set any environment variables for a different SAP system or database.

   If you want to install a primary application server instance, a central services instance, a database instance, or an additional application server instance, make available the Installation Master DVD...
You should make sure the DVDs are available locally. We do not recommend that you use Network File System (NFS), because reading from DVDs mounted with NFS might fail.

3. Start SAPinst from the Installation Master DVD in one of the following ways:
   - Using the **default** installation directory (recommended)
     Enter the following commands:
     
     ```
     cd '/<Installation_Master_DVD>/DATA_UNITS/IM.OS400.PPC64_DB4'
     CALL PGM(QP2TERM) PARM('./sapinst' '-nogui')
     ```
     
     **NOTE**
     There is no GUI on System i, so you will not see a SAPinst Welcome screen. As a default, you must start the SAPinst GUI separately on a Windows 32-bit platform. For more information, see Starting SAPinst GUI Separately (Optional) [page 85].

   - Using an **alternative** installation directory
     If you want to use an alternative installation directory, set the environment variable TEMP, TMP, or TMPDIR.

   - During the installation, the default ports 21200 and 21212 are used for communication between SAPinst, GUI server, and SAPinst GUI. SAPinst uses port 21200 to communicate
with the GUI server. The GUI server uses port 21212 to communicate with SAPinst GUI.
You get an error message if one of these ports is already in use by another service.
In this case, you must execute sapinst using the following parameters:
SAPINST_DIALOG_PORT=<free_port_number_sapinst_gui_to_gui_server>
GUISERVER_DIALOG_PORT=<free_port_number_gui_server_to_sapinst_gui>
GUISERVER_HTTP_PORT=<free_port_number_http_server>.

To get a list of all available SAPinst properties, enter the following command:

```
CALL PGM(QP2TERM) PARM('./sapinst -p')
```

4. In the Welcome screen, choose the required SAPinst installation option from the tree structure.
5. Follow the instructions in the SAPinst input dialogs and enter the required parameters.

**NOTE**

To find more information on each parameter during the input phase of the installation,
position the cursor on the field of the respective parameter and press F1.

6. To start the installation choose Start.
SAPinst starts the installation and displays the progress of the installation. When the installation
has successfully completed, SAPinst displays the screen Execution of Service <Service_Name> has been
completed successfully.

7. **Only valid for: UNIX |**

If required, delete directories with the name sapinst_exe.xxxxx.xxxx after SAPinst has finished.
Sometimes these remain in the temporary directory.

**NOTE**

If there are errors with SAPinst Self-Extractor, you can find the Self-Extractor log file
dev_selfex.out in the temporary directory.

**RECOMMENDATION**

We recommend that you keep all installation directories until you are sure that the system
is completely and correctly installed.

**End of: UNIX |**

8. **Only valid for: IBM i5/OS |**

We recommend that you delete all files in the directory <user_home>/sdtgui/.

9. **Only valid for: IBM i5/OS;UNIX;Windows |**

If you have copied installation DVDs to your hard disk , you can delete these files when the
installation has successfully completed.

**End of: IBM i5/OS |**

## 8.1.5 Starting SAPinst GUI Separately (Optional)

You use this procedure to start SAPinst GUI separately. You might need to start SAPinst GUI separately
in the following cases:
8 Additional Information

8.1 Additional Information About SAPinst

- Only valid for: IBM DB2 for i5/OS |
  You are running System i and did not set a DISPLAY environment variable.

End of: IBM DB2 for i5/OS |

- You have logged off from SAPinst.
  If you logged off during the installation and you later want to reconnect to the installation while it is still running, you can start SAPinst GUI separately.

- You want to perform a remote installation [page 81].
  If SAPinst GUI runs on a different host from SAPinst and the GUI server, you have to start SAPinst GUI separately.

Only valid for: IBM i5/OS | IBM i5/OS | IBM DB2 for i5/OS |

CAUTION
This is the default on System i. Since there is no GUI on System i, you must start the SAPinst GUI separately.

End of: IBM i5/OS | IBM i5/OS | IBM DB2 for i5/OS |

Procedure

Starting SAPinst GUI on a Windows Platform

1. Log on as a member of the local administrators group.
2. Insert the SAP Installation Master DVD into your DVD drive.
3. Change to the directory of the sapinst executables:

   Only valid for: IBM DB2 for Linux and UNIX and Windows;IBM DB2 for z/OS;MaxDB;MS SQL Server;Oracle |
   <DVD drive>:\DATA_UNITS\IM WINDOWS_<platform>_<DB> |

   End of: IBM DB2 for Linux and UNIX and Windows;IBM DB2 for z/OS;MaxDB;MS SQL Server;Oracle |

   Only valid for: IBM DB2 for i5/OS |
   <Installation_Master_DVD>\DATA_UNITS\IM_0S400_PPC_DB4 |

   End of: IBM DB2 for i5/OS |

   Only valid for: IBM DB2 for Linux and UNIX and Windows;IBM DB2 for z/OS;MaxDB;MS SQL Server;Oracle |

   NOTE
   If you want to start SAPinst GUI on a Windows 32-bit platform, change to the following directory:
   <Installation_Master_DVD>\DATA_UNITS\SAPINSTGUI_710_WINDOWS_I386 |

   End of: IBM DB2 for Linux and UNIX and Windows;IBM DB2 for z/OS;MaxDB;MS SQL Server;Oracle |

   Only valid for: IBM DB2 for i5/OS |

   NOTE
   If you want to start SAPinst GUI on a Windows 32-bit platform, you can use the executable available in the i5/OS DVD or change to the following directory:
   <Installation_Master_DVD>\DATA_UNITS\SAPINSTGUI_710_WINDOWS_I386 |

   End of: IBM DB2 for i5/OS |
NOTE

If you have a share ROOTBIN on your System i and you have mapped this share to the drive X, you can start the SAPinst GUI using your copied Installation Master DVD:

X:\tmp\<SID>\<Inst._Master_DVD>\DATA_UNITS\IM_OS400_PPC_64_DB4

For more information, see Copying the DVDs Manually Using the ROOTBIN Share [page 25].

End of: IBM i5/OS | IBM i5/OS | IBM DB2 for i5/OS |

4.

Start SAPinst GUI by double-clicking sapinstgui.exe

SAPinst GUI starts and tries to connect to the GUI server and SAPinst, using the local host as default.

If SAPinst and the GUI server are running on another host, SAPinst GUI cannot connect and the SAP Installation GUI Connection dialog appears.

In this case, enter the name of the host on which SAPinst is running and choose Log on.

The first dialog of the installation appears and you can perform the remote installation from your local host.

NOTE

Optionally you can start sapinstgui.exe with the following parameters:

- **host=<host_name>**, where <host_name> is the host name of the installation host
- **port=<nr>**, where <nr> is the port number for the connection to the GUI server
- **-accessible** enables the Accessibility mode

Example:

```
./sapinstgui.exe host=lsi1209 port=3000 -accessible
```

End of: AIX;HP-UX;IBM i5/OS;Linux;Solaris;Windows |

5.

Start SAPinst GUI in one of the following ways:

- If SAPinst GUI runs on the same host as SAPinst and the GUI server, enter the following command:

  **startinstgui.bat**

  SAPinst GUI uses the local host as default.

- If SAPinst and the GUI server runs on a different host from SAPinst GUI (remote installation), enter the following command:

  **startinstgui.bat -host <host_name>**

  <host_name> is the host name of the installation host.

NOTE

- If you enter the command without additional parameters, SAPinst GUI uses the local host as default. SAPinst GUI starts and tries to connect to the GUI server and SAPinst. Since SAPinst and the GUI server are running on another host, SAPinst GUI cannot connect and the SAP Installation GUI Connection dialog appears.
In this case, enter the name of the host on which SAPinst is running and choose Log on.

The first dialog of the installation appears and you can perform the remote installation from your local host.

- For a list of options to start SAPinst GUI, change to the same directory as your SAPinst executable and enter the command:

`startinstgui.bat -h`

### Starting SAPinst GUI on a UNIX Platform

1. Log on as user root.

   **CAUTION**
   
   Make sure that the root user has not set any environment variables for a different SAP system or database.

2. Mount your Installation Master DVD.

   **NOTE**
   
   Mount the DVD locally. We do not recommend that you use Network File System (NFS).

3. Change to the directory of the sapinst executables:

   `<mountpoint_of_Installation_Master_DVD>/DATA_UNITS/IM_<OS>_<_DB>`

   **NOTE**
   
   If you want to start SAPinst GUI on a Linux 32–bit platform, change to the following directory:

   `<mountpoint_of_Installation_Master_DVD>/DATA_UNITS/SAPINSTGUI_710_LINUX_I386`

4. Only valid for: AIX;HP-UX;IBM i5/OS;Linux;Solaris;Windows |

Start SAPinst GUI by executing `. /sapinstgui`

SAPinst GUI starts and tries to connect to the GUI server and SAPinst, using the local host as default.

If SAPinst and the GUI server are running on another host, SAPinst GUI cannot connect and the **SAP Installation GUI Connection** dialog appears.

In this case, enter the name of the host on which SAPinst is running and choose Log on.

The first dialog of the installation appears and you can perform the remote installation from your local host.

**NOTE**

Optionally you can start sapinstgui with the following parameters:

- `host=<host name>`, where `<host name>` is the host name of the installation host
- `port=<nr>`, where `<nr>` is the port number for the connection to the GUI server
- `- accessible` enables accessibility mode

Example:

`. /sapinstgui host=lsi1209 port=3000 -accessible`
5. Only valid for: z/OS

Start the SAPinst GUI in one of the following ways:

- If SAPinst GUI runs on the same host as SAPinst and the GUI server, enter the following command **without** additional parameters:
  ```
  ./startInstGui.sh
  ```
  By default SAPinst GUI uses the local host.

- If SAPinst and the GUI server run on a different host from SAPinst GUI (remote installation), enter the following command **with** additional parameters:
  ```
  ./startInstGui.sh -host <host_name>
  ```
  `<host_name>` is the host name of the installation host

**NOTE**

- If you enter the command without additional parameters, SAPinst GUI uses the local host as default. SAPinst GUI starts and tries to connect to the GUI server and SAPinst. Since SAPinst and GUI server are running on another host, SAPinst GUI cannot connect and the `SAP Installation GUI Connection` dialog appears. In this case, enter the name of host on which SAPinst is running and choose Log on. The first dialog of the installation appears and you can perform the remote installation from your local host.

- For a list of options to start SAPinst GUI, change to the same directory as your SAPinst executable and enter the command:
  ```
  ./startInstGui.sh -h
  ```

8.1.6 Entries in the Services File Created by SAPinst

After the installation has finished successfully, SAPinst has created the following entries in `/etc/services`:

- `sapdpXX = 32XX/tcp`
- `sapdbXXs = 47XX/tcp`
- `sapgwXX = 33XX/tcp`
- `sapgwXXs = 48XX/tcp`

where `XX` is set from 00 to 99.
8.1.7 Troubleshooting with SAPinst

This section tells you how to proceed when errors occur during the installation with SAPinst.

If an error occurs, SAPinst:

- Stops the installation
- Displays a dialog informing you about the error

**Procedure**

1. To view the log file, choose `View Logs`.
2. If an error occurs during the dialog or processing phase, do one of the following:
   - Try to solve the problem.
   - Abort the installation with `Exit`.
     For more information, see *Interrupted Installation with SAPinst* [page 79].
   - Continue the installation by choosing `Retry`.
3. Only valid for: Windows
   Check the log and trace files of the GUI server and SAPinst GUI in the directory `%userprofile%/.sdtgui/` for errors.
4. Only valid for: IBM i5/OS; UNIX
   Check the log and trace files of the GUI server and SAPinst GUI in the directory `<user_home>/sdtgui/` for errors.
5. Only valid for: IBM i5/OS; UNIX
   If GUI server or SAPinst GUI does not start, check the file `sdtstart.err` in the current `<user_home>` directory.
6. Only valid for: Windows
   If GUI server or SAPinst GUI do not start, check the file `sdtstart.err` in the current `%userprofile%` directory.
7. If SAPinst GUI aborts during the installation without an error message, restart SAPinst GUI as described in *Starting SAPinst GUI Separately.*
## Typographic Conventions

<table>
<thead>
<tr>
<th>Example</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>&lt;Example&gt;</code></td>
<td>Angle brackets indicate that you replace these words or characters with appropriate entries to make entries in the system, for example, “Enter your <code>&lt;User Name&gt;</code>”.</td>
</tr>
<tr>
<td>Example</td>
<td>Arrows separating the parts of a navigation path, for example, menu options</td>
</tr>
<tr>
<td>Example</td>
<td>Emphasized words or expressions</td>
</tr>
<tr>
<td>Example</td>
<td>Words or characters that you enter in the system exactly as they appear in the documentation</td>
</tr>
<tr>
<td><a href="http://www.sap.com">http://www.sap.com</a></td>
<td>Textual cross-references to an internet address</td>
</tr>
<tr>
<td><code>/example</code></td>
<td>Quicklinks added to the internet address of a homepage to enable quick access to specific content on the Web</td>
</tr>
<tr>
<td><code>123456</code></td>
<td>Hyperlink to an SAP Note, for example, SAP Note <code>123456</code></td>
</tr>
</tbody>
</table>
| Example | - Words or characters quoted from the screen. These include field labels, screen titles, pushbutton labels, menu names, and menu options.  
- Cross-references to other documentation or published works |
| Example | - Output on the screen following a user action, for example, messages  
- Source code or syntax quoted directly from a program  
- File and directory names and their paths, names of variables and parameters, and names of installation, upgrade, and database tools |
| EXAMPLE | Technical names of system objects. These include report names, program names, transaction codes, database table names, and key concepts of a programming language when they are surrounded by body text, for example, `SELECT` and `INCLUDE` |
| EXAMPLE | Keys on the keyboard |
Legal Software Terms

Terms for Included Open Source Software

This SAP software contains also the third party open source software products listed below. Note that for these third party products the following special terms and conditions shall apply.

1. This software was developed using ANTLR.
2. SAP License Agreement for STLport
   SAP License Agreement for STLPort between
   SAP Aktiengesellschaft
   Systems, Applications, Products in Data Processing
   Dietmar-Hopp-Allee 16
   69190 Walldorf, Germany
   (hereinafter: SAP)
   and
   you
   (hereinafter: Customer)

   Subject Matter of the Agreement
   1. SAP grants Customer a non-exclusive, non-transferable, royalty-free license to use the STLport.org C++ library (STLport) and its documentation without fee.
   2. By downloading, using, or copying STLport or any portion thereof Customer agrees to abide by the intellectual property laws, and to all of the terms and conditions of this Agreement.
   3. The Customer may distribute binaries compiled with STLport (whether original or modified) without any royalties or restrictions.
   4. Customer shall maintain the following copyright and permissions notices on STLport sources and its documentation unchanged: Copyright 2001 SAP AG
   5. The Customer may distribute original or modified STLport sources, provided that:
      ■ The conditions indicated in the above permissions notice are met;
      ■ The following copyright notices are retained when present, and conditions provided in accompanying permission notices are met:
         Copyright 1994 Hewlett-Packard Company
         Copyright 1996.97 Silicon Graphics Computer Systems Inc.
         Copyright 1997 Moscow Center for SPARC Technology.
         Copyright 1999,2000 Boris Fomitchev
         Copyright 2001 SAP AG

Permission to use, copy, modify, distribute and sell this software and its documentation for any purposes is hereby granted without fee, provided that the above copyright notice appear in all copies and that both that copyright notice and this permission notice appear in supporting documentation. Hewlett-Packard Company makes no representations about the suitability of this software for any purpose. It is provided "as is" without express or implied warranty.

Permission to use, copy, modify, distribute and sell this software and its documentation for any purpose is hereby granted without fee, provided that the above copyright notice appear in all copies and that both that copyright notice and this permission notice appear in supporting documentation. Silicon Graphics makes no representations about the suitability of this software for any purpose. It is provided “as is” without express or implied warranty.

Permission to use, copy, modify, distribute and sell this software and its documentation for any purposes is hereby granted without fee, provided that the above copyright notice appear in all copies and that both that copyright notice and this permission notice appear in supporting documentation. Moscow Center for SPARC makes no representations about the suitability of this software for any purpose. It is provided “as is” without express or implied warranty.

Boris Fomitchev makes no representations about the suitability of this software for any purpose. This material is provided “as is”, with absolutely no warranty expressed or implied. Any use is at your own risk. Permission to use or copy this software for any purpose is hereby granted without fee, provided the above notices are retained on all copies. Permission to modify the code and to distribute modified code is granted, provided the above notices are retained, and a notice that the code was modified is included with the above copyright notice.
Permission to use, copy, modify, distribute and sell this software and its documentation for any purposes is hereby granted without fee, provided that the above copyright notice appear in all copies and that both that copyright notice and this permission notice appear in supporting documentation. SAP makes no representations about the suitability of this software for any purpose. It is provided with a limited warranty and liability as set forth in the License Agreement distributed with this copy. SAP offers this liability and warranty obligations only towards its customers and only referring to its modifications.

2. Support and Maintenance
SAP does not provide software maintenance for the STLport. Software maintenance of the STLport therefore shall be not included.
All other services shall be charged according to the rates for services quoted in the SAP List of Prices and Conditions and shall be subject to a separate contract.

3. Exclusion of warranty
As the STLport is transferred to the Customer on a loan basis and free of charge, SAP cannot guarantee that the STLport is error-free, without material defects or suitable for a specific application under third-party rights. Technical data, sales brochures, advertising text and quality descriptions produced by SAP do not indicate any assurance of particular attributes.

4. Limited Liability
1. Irrespective of the legal reasons, SAP shall only be liable for damage, including unauthorized operation, if this (i) can be compensated under the Product Liability Act or (ii) if caused due to gross negligence or intent by SAP or (iii) if based on the failure of a guaranteed attribute.
2. If SAP is liable for gross negligence or intent caused by employees who are neither agents or managerial employees of SAP, the total liability for such damage and a maximum limit on the scope of any such damage shall depend on the extent to which its occurrence ought to have anticipated by SAP when concluding the contract, due to the circumstances known to it at that point in time representing a typical transfer of the software.
3. In the case of Art. 4.2 above, SAP shall not be liable for indirect damage, consequential damage caused by a defect or lost profit.
4. SAP and the Customer agree that the typical foreseeable extent of damage shall under no circumstances exceed EUR 5,000.
5. The Customer shall take adequate measures for the protection of data and programs, in particular by making backup copies at the minimum intervals recommended by SAP. SAP shall not be liable for the loss of data and its recovery, notwithstanding the other limitations of the present Art. 4 if this loss could have been avoided by observing this obligation.
6. The exclusion or the limitation of claims in accordance with the present Art. 4 includes claims against employees or agents of SAP.

3. Adobe Document Services
Adobe, the Adobe logo, Acrobat, PostScript, and Reader are either registered trademarks or trademarks of Adobe Systems Incorporated in the United States and/or other countries. For information on Third Party software delivered with Adobe document services and Adobe LiveCycle Designer, see SAP Note 854621.

Documentation in the SAP Service Marketplace
You can find this document at the following address: https://service.sap.com/instguides